Acknowledgments

Perspection, Inc.

Adobe Photoshop CC on Demand has been created by the professional trainers and writers at Perspection, Inc. to the standards you’ve come to expect from Que publishing. Together, we are pleased to present this training book.

Perspection, Inc. is a software training company committed to providing information and training to help people use software more effectively in order to communicate, make decisions, and solve problems. Perspection writes and produces software training books, and develops multimedia and web-based training. Since 1991, we have written more than 120 computer books, with several bestsellers to our credit, and sold over 5 million books.

This book incorporates Perspection’s training expertise to ensure that you’ll receive the maximum return on your time. You’ll focus on the tasks and skills that increase productivity while working at your own pace and convenience.

We invite you to visit the Perspection web site at:

www.perspection.com

Acknowledgments

The task of creating any book requires the talents of many hard-working people pulling together to meet impossible deadlines and untold stresses. We’d like to thank the outstanding team responsible for making this book possible: the writer, Steve Johnson; the production editor, James Teyler; proofreader, Beth Teyler; and the indexer, Katherine Stimson.

At Que publishing, we’d like to thank Greg Wiegand and Laura Norman for the opportunity to undertake this project, Cindy Teeters for administrative support, and Sandra Schroeder for your production expertise and support.

Perspection
About the Author

Steve Johnson has written more than 80 books on a variety of computer software, including Adobe Edge Animate, Adobe Photoshop CS6, Adobe Dreamweaver CS6, Adobe InDesign CS6, Adobe Illustrator CS6, Adobe Flash Professional CS5, Microsoft Windows 8, Microsoft Office 2013 and 2010, Microsoft Office 2008 for the Macintosh, and Apple OS X Mountain Lion. In 1991, after working for Apple Computer and Microsoft, Steve founded Perspection, Inc., which writes and produces software training. When he is not staying up late writing, he enjoys coaching baseball, playing golf, gardening, and spending time with his wife, Holly, and three children, JP, Brett, and Hannah. Steve and his family live in Northern California, but can also be found visiting family all over the western United States.
**We Want to Hear from You!**

As the reader of this book, you are our most important critic and commentator. We value your opinion and want to know what we’re doing right, what we could do better, what areas you’d like to see us publish in, and any other words of wisdom you’re willing to pass our way.

As an associate publisher for Que, I welcome your comments. You can email or write me directly to let me know what you did or didn’t like about this book—as well as what we can do to make our books better.

Please note that I cannot help you with technical problems related to the topic of this book. We do have a User Services group, however, where I will forward specific technical questions related to the book.

When you write, please be sure to include this book’s title and author as well as your name, email address, and phone number. I will carefully review your comments and share them with the author and editors who worked on the book.

Email: feedback@quepublishing.com

Mail: Greg Wiegand
     Que Publishing
     800 East 96th Street
     Indianapolis, IN 46240 USA

For more information about this book or another Que title, visit our web site at www.quepublishing.com. Type the ISBN (excluding hyphens) or the title of a book in the Search field to find the page you’re looking for.
This page intentionally left blank
# Contents

**Introduction**

1. **Getting Started with Photoshop CC**
   - Installing Photoshop: 2 \textit{New!}
   - Starting Photoshop: 4 \textit{New!}
   - Viewing the Photoshop Window: 6 \textit{New!}
   - Showing and Hiding Panels: 7
   - Working with Panels: 8
   - Working with Photoshop Tools: 10
   - Creating a New Document: 12
   - Selecting Color Modes and Resolution: 13
   - Creating a New Document Using Presets: 14
   - Working with Non-Square Pixels: 15
   - Opening Images: 16 \textit{New!}
   - Inserting Images in a Document: 17
   - Importing Raw Data from a Digital Camera: 18 \textit{New!}
   - Working with Smart Objects: 20
   - Changing Image Size and Resolution: 22 \textit{New!}
   - Checking for Updates Online: 24 \textit{New!}
   - Getting Help While You Work: 26
   - Saving a Document: 28 \textit{New!}
   - Using the Status Bar: 30 \textit{New!}
   - Closing a Document: 31
   - Finishing Up: 32

2. **Understanding Navigation and Measurement Systems**
   - Changing the View Size with the Navigator Panel: 34
   - Changing the View Area with the Navigator Panel: 35
   - Changing the Color of the Navigator Panel View Box: 36
   - Changing the Screen Display Mode: 37
   - Changing the View with the Zoom Tool: 38 \textit{New!}
   - Increasing or Decreasing Magnification: 40 \textit{New!}
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Customizing the Way You Work</td>
<td>55</td>
</tr>
<tr>
<td></td>
<td>Optimizing Photoshop</td>
<td>56</td>
</tr>
<tr>
<td></td>
<td>Setting General Preferences</td>
<td>58</td>
</tr>
<tr>
<td></td>
<td>Setting File Handling Preferences</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>Setting Interface Preferences</td>
<td>62</td>
</tr>
<tr>
<td></td>
<td>Changing Sync Settings Preferences</td>
<td>64</td>
</tr>
<tr>
<td></td>
<td>Setting Cursors Preferences</td>
<td>66</td>
</tr>
<tr>
<td></td>
<td>Controlling Transparency &amp; Gamut Preferences</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Working with Units &amp; Rulers</td>
<td>68</td>
</tr>
<tr>
<td></td>
<td>Working with Guides, Grid &amp; Slices</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>Setting Plug-Ins Preferences</td>
<td>72</td>
</tr>
<tr>
<td></td>
<td>Selecting Scratch Disks</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>Allocating Memory &amp; Image Cache</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>Setting Type Preferences</td>
<td>76</td>
</tr>
<tr>
<td></td>
<td>Managing Libraries with the Preset Manager</td>
<td>77</td>
</tr>
<tr>
<td></td>
<td>Using and Customizing Workspaces</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>Building Specialized Workspaces</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Creating a Customized User Interface</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>Defining Shortcut Keys</td>
<td>82</td>
</tr>
<tr>
<td>4</td>
<td>Mastering the Art of Selection</td>
<td>83</td>
</tr>
<tr>
<td></td>
<td>Using the Rectangular Marquee Tool</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>Using the Elliptical Marquee Tool</td>
<td>85</td>
</tr>
<tr>
<td></td>
<td>Using the Single Row and Single Column Marquee Tools</td>
<td>86</td>
</tr>
<tr>
<td></td>
<td>Using the Lasso Marquee Tool</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>Using the Magnetic Lasso Tool</td>
<td>88</td>
</tr>
<tr>
<td></td>
<td>Using the Polygonal Lasso Tool</td>
<td>90</td>
</tr>
<tr>
<td></td>
<td>Using the Quick Selection Tool</td>
<td>91</td>
</tr>
<tr>
<td></td>
<td>Using the Magic Wand Tool</td>
<td>92</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>Selecting by Color Range</td>
<td>93</td>
<td></td>
</tr>
<tr>
<td>Refining a Selection Edge</td>
<td>94</td>
<td></td>
</tr>
<tr>
<td>Modifying an Existing Selection</td>
<td>96</td>
<td></td>
</tr>
<tr>
<td>Working with an Existing Selection</td>
<td>98</td>
<td></td>
</tr>
<tr>
<td>Copying and Pasting a Selection</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>Using Channels to Create and Store Selections</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>Using Free Transform and Transform</td>
<td>102</td>
<td></td>
</tr>
<tr>
<td>Using the Crop Tool</td>
<td>104</td>
<td></td>
</tr>
<tr>
<td>Using the Perspective Crop Tool</td>
<td>106</td>
<td></td>
</tr>
<tr>
<td>Using Content-Aware Scaling</td>
<td>107</td>
<td></td>
</tr>
<tr>
<td>Using Content-Aware Fill</td>
<td>108</td>
<td></td>
</tr>
<tr>
<td>Using Content-Aware Patch</td>
<td>110</td>
<td></td>
</tr>
<tr>
<td>Using Content-Aware Move and Extend</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>Using the Puppet Warp</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>Working with Layers</td>
<td>113</td>
<td></td>
</tr>
<tr>
<td>Understanding the Layers Panel</td>
<td>114</td>
<td></td>
</tr>
<tr>
<td>Defining Layer Designations and Attributes</td>
<td>115</td>
<td></td>
</tr>
<tr>
<td>Creating a New Layer</td>
<td>116</td>
<td></td>
</tr>
<tr>
<td>Selecting Layers</td>
<td>118</td>
<td></td>
</tr>
<tr>
<td>Creating a Layer Group</td>
<td>119</td>
<td></td>
</tr>
<tr>
<td>Creating a Selection from a Layer</td>
<td>120</td>
<td></td>
</tr>
<tr>
<td>Creating a Layer from a Selection</td>
<td>121</td>
<td></td>
</tr>
<tr>
<td>Converting a Background into a Layer</td>
<td>122</td>
<td></td>
</tr>
<tr>
<td>Controlling Image Information Using the Layers Panel</td>
<td>124</td>
<td></td>
</tr>
<tr>
<td>Filtering Layers</td>
<td>125</td>
<td></td>
</tr>
<tr>
<td>Isolating Layers</td>
<td>126</td>
<td></td>
</tr>
<tr>
<td>Moving and Copying Layers</td>
<td>127</td>
<td></td>
</tr>
<tr>
<td>Duplicating a Layer</td>
<td>128</td>
<td></td>
</tr>
<tr>
<td>Deleting Layers</td>
<td>129</td>
<td></td>
</tr>
<tr>
<td>Using Merge Layer Options</td>
<td>130</td>
<td></td>
</tr>
<tr>
<td>Linking and Unlinking Layers</td>
<td>131</td>
<td></td>
</tr>
<tr>
<td>Aligning and Combining Layers</td>
<td>132</td>
<td></td>
</tr>
<tr>
<td>Aligning Layers with Smart Guides</td>
<td>134</td>
<td></td>
</tr>
<tr>
<td>Working with Layer Blending Modes</td>
<td>135</td>
<td></td>
</tr>
<tr>
<td>Setting Layer Opacity</td>
<td>136</td>
<td></td>
</tr>
<tr>
<td>Working with the Layer Comps Panel</td>
<td>137</td>
<td></td>
</tr>
<tr>
<td>Exporting Layers as Files</td>
<td>138</td>
<td></td>
</tr>
<tr>
<td>Copying CSS from Layers</td>
<td>139</td>
<td></td>
</tr>
<tr>
<td>Setting Layers Panel Options</td>
<td>140</td>
<td></td>
</tr>
</tbody>
</table>
6 Working with the History Panel 141
   Setting History Panel Options 142
   Working with Linear and Non-Linear History 144
   Controlling the Creative Process with Snapshots 146
   Duplicating a History State in Another Document 147
   Saving the History State of a Document 148
   Reviewing the History State Text File 149
   Combining the History Brush with a History State 150
   Using the Art History Brush 152
   Changing the Eraser Tool into the History Brush 153
   Controlling History States 154

7 Working with Adjustment Layers, Filters, and Tools 155
   Creating an Adjustment Layer 156
   Modifying an Adjustment Layer 157
   Merging Adjustment Layers 158
   Creating a Temporary Composite Image 159
   Controlling Adjustment Layers with Clipping Groups 160
   Deleting an Adjustment Layer 161
   Using Blending Modes and Opacity with Layers 162
   Using Masks with Adjustment Layers 164
   Creating Masks with Selections 165
   Using the Add Noise Filter 166
   Using the Reduce Noise Filter 167
   Keeping Proper Perspective with Vanishing Point 168 New!
   Working with the Lens Correction Filter 170
   Using the Box, Surface, and Shape Blur Filters 172
   Using the Gaussian Blur and Despeckle Filters 174
   Using the Unsharp Mask Filter 175
   Using the Shake Reduction Filter 176 New!
   Using the Smart Sharpen Filter 178 New!
   Using Sharpen, Blur and Smudge Tools 180
   Using the Clone Stamp Tool 181
   Setting Up Multiple Clone Sources 182
   Using the Dodge and Burn Tools 183
   Using the Healing Brush and Patch Tools 184
   Working with the Spot Healing Brush 186
   Working with the Red Eye Tool 187
   Controlling Tonal Range 188
   Working with the Histogram Panel 190
8 Understanding Colors and Channels 191
  Working with 8-, 16-, and 32-Bit Images 192
  Working with the Channels Panel 194
  Working with Color Modes 195
  Understanding the RGB Color Mode 196
  Understanding the CMYK Color Mode 197
  Understanding the Grayscale Color Mode 198
  Understanding the Bitmap Color Mode 199
  Understanding the Indexed Color Mode 200
  Understanding the Lab Color Mode 202
  Understanding the Duotone Color Mode 203
  Using the Multichannel Color Mode 204
  Using the Replace Color Adjustment 205
  Working with the Color Panel 206 New!
  Working with the Swatches Panel 208 New!
  Using the Stroke and Fill Commands 210
  Creating Spot Color Channels 212
  Using the Auto Contrast and Auto Color Commands 213
  Using Levels Adjustment Commands 214
  Using the Exposure Adjustment 215
  Using Curves and Color Adjustments 216
  Adjusting Hue and Saturation 218
  Adjusting Vibrance 219
  Using the Selective Color Adjustment 220
  Using the Channel Mixer Adjustment 221
  Using the Gradient Map Adjustment 222
  Using the Photo Filter Adjustment 223
  Using the Invert and Equalize Commands 224
  Using the Threshold and Posterize Adjustments 225
  Using the HDR Toning Adjustment 226
  Using the Shadows/Highlights Adjustment 228
  Using the Black & White Adjustment 229
  Using the Match Color Adjustment 230

9 Using the Paint, Shape Drawing, and Eraser Tools 231
  Selecting Foreground and Background Colors 232
  Using the Brush and Brush Presets Panel 234
  Modifying the Brush Presets Panel 235
  Selecting Brush Tip Sets 236
  Adjusting Brush Tips 237
Adjusting Bristle Brush Tips 238
Creating Customized Brush Tips 239
Saving Customized Brush Tips 240
Working with the Brush and Airbrush Tools 241
Working with the Mixer Brush Tool 242
Working with the Pencil Tool 243
Working with Auto Erase 244
Working with the Line Tool 245
Working with the Shape Tool 246
Working with the Custom Shape Tool 247
Working with Shape Layers 248 **New!**
Arranging Shape Layers 250
Creating a Custom Shape 251
Saving Custom Shape Sets 252
Using the Paint Bucket Tool 253
Working with the Eraser Tools 254
Working with the Magic Eraser Tool 256
Creating and Applying Gradients 257
Creating and Saving Customized Gradients 258
Using the Color Replacement Tool 260

10 Creating Masks 261
Understanding Layer and Vector Masks 262
Creating a Layer Mask 263
Using Paint Tools with Layer Masks 264
Using Selections to Generate Complex Layer Masks 265
Using Layer Masks to Generate Soft Transparency 266
Creating Unique Layer Mask Effects 267
Creating a Vector Mask 268
Modifying Layer and Vector Masks 269
Modifying Selection Masks 270 **New!**
Creating Channel Masks 272
Creating Channel Masks from Scratch 273
Modifying Channel Mask Options 274
Creating Channel Masks from Selections 275
Making Channel Masks from Native Color Channels 276
Loading Channel Masks from Selections 278
Moving Channel Masks Between Documents 280
Combining Channel Masks 281
Using the Quick Mask Mode 282
11 Using the Paths Panel 285
   Understanding Vector and Raster Images 286
   Converting a Selection into a Path 287
   Working with Pen Tools 288 New!
   Creating Paths Using the Freeform Pen Tool 290
   Using the Magnetic Option with the Freeform Pen Tool 291
   Adding and Deleting Anchor Points 292 New!
   Modifying Anchor Points 294 New!
   Modifying Existing Direction Lines 296
   Converting Straight Points and Curved Points 297
   Working with Clipping Paths 298
   Filling an Area of an Image Using Paths 300
   Stroking an Area of an Image Using Paths 301
   Creating Shapes as Paths 302
   Exporting Paths to Adobe Illustrator 303
   Exporting Paths Using the Export Method 304

12 Working with Layer Styles 305
   Understanding Layer Styles 306
   Adding a Layer Style 307
   Creating and Modifying a Drop Shadow 308
   Working with Bevel and Emboss 310
   Working with Contour and Texture 312
   Applying a Color Overlay 314
   Using the Stroke Layer Style 315
   Using Pattern Overlays 316
   Working with Outer Glow and Inner Shadow 318
   Applying an Inner Glow Style 320
   Creating Customized Layer Styles 322
   Creating Customized Styles Using the Styles Panel 324
   Moving Existing Layer Styles 326

13 Getting Creative with Type 327
   Using Standard Type Tools 328
   Working with Type Options 330
   Working with the Character Panel 332
   Working with the Paragraph Panel 334
   Setting Anti-aliasing Options 335 New!
Using the Warp Text Option 336
Creating Type Styles 338
Working with Type Styles 340
Working with Default Type Styles 341 New!
Using Spell Check 342
Finding and Replacing Text 343
Using the Rasterize Type Command 344
Creating Work Paths and Shapes from Type Layers 345
Creating Shape Layers 346
Creating a Type Mask 347
Isolating Image Pixels Using a Type Mask 348
Creating Chiseled Type with a Type Mask 350
Using Masks to Generate Special Effects 352
Creating and Modifying Text on a Path 354

Manipulating Images with Filters 355

Working with the Filter Gallery 356
Creating and Working with Smart Filters 358 New!
Applying Multiple Filters to an Image 359
Applying the Liquify Filter 360 New!
Working with Liquify Options 362 New!
Working with Liquify Mask Options 364
Working with Liquify View Options 365
Creating a Liquify Mesh 366
Applying a Liquify Mesh 367
Using the Camera Raw Filter 368 New!
Using the Upright Filter 369 New!
Using the Radial Filter 370 New!
Using the Spot Removal Filter 371 New!
Using the Adaptive Wide Angle Filter 372
Using the Oil Paint Filter 374
Using the Lighting Effects Filter 375
Using the Blur Filter Gallery 376 New!
Using the Lens Blur Filter 378
Working with Photo Filters 380
Blending Modes and Filter Effects 381
Building Custom Patterns 382
Applying a Fade Effect 384
Controlling Filters Using Selections 385
Using a Channel Mask to Control Filter Effects 386
Protecting Images with Watermarks 388
Viewing Various Filter Effects 390

15 Automating Your Work with Actions 393
Examining the Actions Panel 394 New!
Building a New Action 396
Recording an Action 397
Adding a Stop to an Action 398
Controlling the Playback of a Command 399
Adding a Command to an Action 400
Deleting a Command from an Action 401
Working with Modal Controls in an Action 402
Changing the Order of Commands in an Action 403
Copying an Action 404
Running an Action Inside an Action 405
Setting a Condition in an Action 406 New!
Inserting a Non-Recordable Command into an Action 407
Moving and Copying Actions Between Sets 408
Saving Actions into Sets 409
Saving Actions as Files 410
Running a Built-in or Custom a Script 411
Enhancing the Process with Droplets 412
Using a Droplet 414

16 Controlling Image Output 415
Setting Document Print Options 416
Setting Print Output Options 418
Setting Print Color Management Options 420
Printing a Document in Macintosh 422
Printing a Document in Windows 424
Changing Printer Settings 425
Printing One Copy 426
Understanding File Formats 427
Saving a Document with a Different File Format 428
Inserting File Information into a Document 430
Understanding File Compression 432
Understanding Monitor, Image, and Device Resolution 433
Preparing Clip Art for the Web 434
Preparing a Photograph for the Web 436
Preparing an Image for the Press 438
Preparing an Image for an Inkjet or Laser Printer 440
Sharing on Behance 442
New!

17 Working with Automate Commands 443
   Working with Batch File Processing 444
   Working with Conditional Mode Change 446
   Cropping and Straightening Photos 447
   Converting a Multi-Page PDF to PSD 448
   Creating a PDF Document 450
   Creating a Contact Sheet 452
   Creating Panoramic Images 454
   Processing Lens Correction 456
   Merging Images to HDR Pro 458
   Processing Multiple Image Files 460
   Adjusting an Image Fit Size 462

18 Managing Color from Monitor to Print 463
   Producing Consistent Color 464
   Calibrating Using Hardware and Software 465
   Setting Up Soft-Proof Colors 466
   Changing from Additive (RGB) to Subtractive (CMYK) 468
   Working with Rendering Intents 469
   Printing a Hard Proof 470
   Working with Color Management 472
   Embedding ICC Color Profiles 474
   Assigning a Different Profile to a Document 475
   Converting Document Colors to Another Profile 476
   Using Hue/Saturation for Out-Of-Gamut Colors 478
   Using the Sponge Tool for Out-Of-Gamut Colors 480
   Working with the Out-Of-Gamut Warning 482

19 Designing for the Web and Devices 483
   Saving for the Web 484
   Working with Save for Web Options 486
   Optimizing an Image to File Size 487
   Working with Web File Formats 488
   Optimizing a JPEG Document 490
   Optimizing a GIF Document 492
   Optimizing a PNG-8 Document 494 New!
   Optimizing a PNG-24 Document 496 New!
   Optimizing a WBMP Document 497
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slicing Images the Easy Way</td>
<td>498</td>
</tr>
<tr>
<td>Working with Slices</td>
<td>500</td>
</tr>
<tr>
<td>Arranging Slices</td>
<td>502</td>
</tr>
<tr>
<td>Saving a Sliced Image for the Web</td>
<td>504</td>
</tr>
<tr>
<td>Adding HTML Text or an URL Link to a Slice</td>
<td>506</td>
</tr>
<tr>
<td>Defining and Editing Web Data Variables</td>
<td>508</td>
</tr>
<tr>
<td>Exporting an Image to Zoomify</td>
<td>510</td>
</tr>
<tr>
<td>Working with Video</td>
<td>511</td>
</tr>
<tr>
<td>Opening Video Files and Image Sequences</td>
<td>512</td>
</tr>
<tr>
<td>Creating a Video Layer</td>
<td>513</td>
</tr>
<tr>
<td>Modifying a Video Layer</td>
<td>514</td>
</tr>
<tr>
<td>Creating a Video Group</td>
<td>516</td>
</tr>
<tr>
<td>Adding Text to a Video Layer</td>
<td>517</td>
</tr>
<tr>
<td>Splitting a Video Layer</td>
<td>518</td>
</tr>
<tr>
<td>Cloning Video Layer Content</td>
<td>519</td>
</tr>
<tr>
<td>Adding a Transition to a Video Layer</td>
<td>520</td>
</tr>
<tr>
<td>Adding Audio to a Video Layer</td>
<td>521</td>
</tr>
<tr>
<td>Creating an Animation</td>
<td>522</td>
</tr>
<tr>
<td>Working with Animation</td>
<td>524</td>
</tr>
<tr>
<td>Exporting Directly to Video</td>
<td>526</td>
</tr>
<tr>
<td>Creating an Image from a Video</td>
<td>528</td>
</tr>
<tr>
<td>Working with 3D Models</td>
<td>529</td>
</tr>
<tr>
<td>Setting 3D Preferences</td>
<td>530</td>
</tr>
<tr>
<td>Creating 3D Models</td>
<td>532</td>
</tr>
<tr>
<td>Creating 3D Models Using Preset Shapes</td>
<td>534</td>
</tr>
<tr>
<td>Viewing the 3D Workspace</td>
<td>535</td>
</tr>
<tr>
<td>Modifying 3D Models</td>
<td>536</td>
</tr>
<tr>
<td>Working with 3D Models</td>
<td>538</td>
</tr>
<tr>
<td>Painting 3D Models</td>
<td>539</td>
</tr>
<tr>
<td>Creating 3D Text</td>
<td>540</td>
</tr>
<tr>
<td>Adjusting Light with 3D Models</td>
<td>541</td>
</tr>
<tr>
<td>Rendering and Saving 3D Models</td>
<td>542</td>
</tr>
<tr>
<td>Working Together with Adobe Programs</td>
<td>543</td>
</tr>
<tr>
<td>Exploring Adobe Programs</td>
<td>544</td>
</tr>
<tr>
<td>Exploring Adobe Bridge</td>
<td>545</td>
</tr>
<tr>
<td>Getting Started with Adobe Bridge</td>
<td>546</td>
</tr>
<tr>
<td>Getting Photos from a Digital Camera</td>
<td>547</td>
</tr>
<tr>
<td>Working with Raw Images from a Digital Camera</td>
<td>548</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Modifying Images in Camera Raw</td>
<td>550</td>
</tr>
<tr>
<td>Working with Images Using Adobe Bridge</td>
<td>552</td>
</tr>
<tr>
<td>Setting Preferences in Adobe Bridge</td>
<td>554</td>
</tr>
<tr>
<td>Applying Image Adjustments</td>
<td>556</td>
</tr>
<tr>
<td>Automating Tasks in Adobe Bridge</td>
<td>557</td>
</tr>
<tr>
<td>Using Mini Bridge</td>
<td>558</td>
</tr>
<tr>
<td>Scripting with Adobe ExtendScript Toolkit</td>
<td>559</td>
</tr>
<tr>
<td>Working with Adobe Media Encoder</td>
<td>560</td>
</tr>
<tr>
<td>Working with Adobe Extension Manager</td>
<td>562</td>
</tr>
<tr>
<td>Using the Adobe Exchange Panel</td>
<td>563</td>
</tr>
<tr>
<td>Accessing Adobe Creative Cloud</td>
<td>564</td>
</tr>
<tr>
<td><strong>New Features</strong></td>
<td>565</td>
</tr>
<tr>
<td>Adobe Certification</td>
<td>571</td>
</tr>
<tr>
<td>Adobe Certified Expert (ACE)</td>
<td>571</td>
</tr>
<tr>
<td>Adobe Certified Associate (ACA)</td>
<td>574</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>577</td>
</tr>
</tbody>
</table>
Welcome to Adobe Photoshop CC on Demand, a visual quick reference book that shows you how to work efficiently with Photoshop. This book provides complete coverage of basic to advanced Photoshop skills.

How This Book Works

You don’t have to read this book in any particular order. We’ve designed the book so that you can jump in, get the information you need, and jump out. However, the book does follow a logical progression from simple tasks to more complex ones. Each task is presented on no more than two facing pages, which lets you focus on a single task without having to turn the page. To find the information that you need, just look up the task in the table of contents or index, and turn to the page listed. Read the task introduction, follow the step-by-step instructions in the left column along with screen illustrations in the right column, and you’re done.

What’s New

If you’re searching for what’s new in Photoshop CC, just look for the icon: New!. The new icon appears in the table of contents and throughout this book so you can quickly and easily identify a new or improved feature in Photoshop. A complete description of each new feature appears in the New Features guide in the back of this book.

Keyboard Shortcuts

Most menu commands have a keyboard equivalent, such as Ctrl+P (Win) or ⌘+P (Mac), as a quicker alternative to using the mouse. A complete list of keyboard shortcuts is available on the web at www.perspection.com.
**Step-by-Step Instructions**

This book provides concise step-by-step instructions that show you “how” to accomplish a task. Each set of instructions includes illustrations that directly correspond to the easy-to-read steps. Also included in the text are time-savers, tables, and sidebars to help you work more efficiently or to teach you more in-depth information. A “Did You Know?” provides tips and techniques to help you work smarter, while a “See Also” leads you to other parts of the book containing related information about the task.

**Real World Examples**

This book uses real world examples files to give you a context in which to use the task. By using the example files, you won’t waste time looking for or creating sample files. You get a start file and a result file, so you can compare your work. Not every topic needs an example file, such as changing options, so we provide a complete list of the example files used throughout the book. The example files that you need for project tasks along with a complete file list are available on the web at www.queondemand.com or www.perspection.com.
Workshops

This book shows you how to put together the individual step-by-step tasks into in-depth projects with the Workshop. You start each project with a sample file, work through the steps, and then compare your results with project results file at the end. The Workshop projects and associated files are available on the web at www.queondemand.com or www.perspection.com.

Adobe Certification

This book prepares you for the Adobe Certified Expert (ACE) and Adobe Certified Associate (ACA) exams for Adobe Photoshop CC. Each Adobe certification exam has a set of objectives, which are organized into broader skill sets. To prepare for a certification exam, you should review and perform each task identified with an ACE or ACA objective to confirm that you can meet the requirements for the exam. Information about the ACE and ACA programs are available in the back of this book. The ACE and ACA objectives and the specific pages that cover them are available on the web at www.queondemand.com or www.perspection.com.
Get More on the Web

In addition to the information in this book, you can also get more information on the web to help you get up to speed faster with Photoshop CC. Some of the information includes:

Transition Helpers

- **Only New Features.** Download and print the new feature tasks as a quick and easy guide.

Productivity Tools

- **Keyboard Shortcuts.** Download a list of keyboard shortcuts to learn faster ways to get the job done.

More Content

- **Photographs.** Download photographs and other graphics to use in your Photoshop documents.
- **More Content.** Download new content developed after publication.

You can access these additional resources on the web at www.perspection.com.
Customizing the Way You Work

Introduction

No description of Adobe Photoshop would be complete without that well-known, but little utilized area called Preferences. Photoshop preferences serve several purposes. They help customize the program to your particular designing style, and they help you utilize available computer resources to increase the overall performance of the program.

By modifying File Handling preferences, such as appending a file extension on the file, or being asked when saving a layered TIFF file, you can streamline the file saving process. In addition, you can change the way your cursors look. For example, do you want your paintbrush to look like a paintbrush when you paint, do you prefer a precision crosshair or the actual brush size shape, or the shape with a crosshair?

As you use Photoshop, you’ll come to realize the importance of working with units and rulers. Precision is the name of the game when you are working with images. What about the color of your guides, grids, and slices? No big deal, you say. Well, if you’ve ever tried viewing a blue guide against a blue-sky image, you know exactly why guide color is important. By working through preferences such as Image Cache, Scratch Disks, and RAM (Random Access Memory), speed increases of up to 20% can be achieved.

In addition, customizing the program helps make you more comfortable, and studies show that the more comfortable you are as a designer, the better your designs. Plus, being comfortable allows you to work faster, and that means you’ll accomplish more in the same amount of time. What does setting up preferences do for you? They make Photoshop run faster (up to 20%), you work more efficiently, and your designs are better. That’s a pretty good combination. Photoshop doesn’t give you Preferences to confuse you, but to give you choices, and those choices give you control.

What You’ll Do

- Optimize Photoshop
- Set General Preferences
- Set File Handling Preferences
- Set Interface Preferences
- Change Sync Settings Preferences
- Set Cursors Preferences
- Control Transparency & Gamut Preferences
- Change Units & Rulers Preferences
- Change Guides, Grid & Slices Preferences
- Set Plug-Ins Preferences
- Select Scratch Disks
- Allocate Memory & Image Cache
- Set Type Preferences
- Manage Libraries with the Preset Manager
- Use and Customize Workspaces
- Build Specialized Workspaces
- Create a Customized User Interface
- Define Shortcut Keys
Optimizing Photoshop

Photoshop is a powerful program, and as such, requires a tremendous amount of computing power. When working on large documents, a poorly optimized Photoshop program will mean longer processing times for your files. That’s the bad news if you have a deadline to meet. The good news is that Photoshop can be configured to run more efficiently. To optimize Photoshop, click the Edit (Win) or Photoshop (Mac) menu, point to Preferences, and then click Performance. The Performance preferences dialog box contains options that will help maximize the performance of Photoshop.

History States

History States control the number of undos available. In fact, you can have up to 1,000 undos (ever wonder who would make so many mistakes that they would need 1,000 undos?). Unfortunately, increasing the number of History States will ultimately increase the amount of RAM Photoshop uses to manage the History panel. Assigning more RAM to manage History means less memory for Photoshop to perform other operations, and will reduce the performance of the program. If you are experiencing problems with slow performance, lowering the number of History States frees up more RAM, and permits Photoshop to operate more efficiently.

Scratch Disk

When your computer doesn’t have enough RAM to perform an operation, Photoshop uses free space on any available drive, known as a Scratch Disk. Photoshop requires 5 times the working size of the file in contiguous hard drive space. For example, if the working size of your file is 100 MB, you will need 500 MB of contiguous hard drive space, or you will receive an error message: Out of Scratch Disk Space (I hate it when that happens). Using additional hard drives gives Photoshop the ability to...
divide the processing load and increase performance. Photoshop detects and displays all available internal disks in the Preferences dialog box. Scratch disks must be physically attached to your computer (avoid networks and removable media, such as USB drives, or rewritable CDs or DVDs). For maximum speed, avoid USB, and use 4- or 6-pin FireWire drives. Benchmark tests show FireWire drives provide up to a 20% speed improvement when used as Scratch Disks. Think of saving one hour out of every five, or one full day out of every five. That’s not too bad. For best results, select a scratch disk on a different drive than the one used for virtual memory or any large files you’re editing.

Memory & Image Cache
Photoshop functions in RAM (actually all applications work within RAM). To run efficiently, Photoshop requires 5 times the working size of the open document in available memory (some tests indicate 6 to 8 times). Strictly speaking, the more RAM you can assign to Photoshop, the more efficiently the program operates, especially when opening large documents. RAM usage is determined by the working size of the document, not its open size. As you add elements to a document, the working size of the file increases.

Cache Levels are screen redraws, or how many versions of the current active document Photoshop saves. When you’re working on large documents, more Cache Levels help speed up the redraw function, and make image manipulation proceed faster. However, they are held primarily in RAM, so the more Cache Levels you choose, the less RAM is available for other Photoshop functions. Cache Tiles are the amount of data Photoshop stores or processes at once; use a larger tile size for larger documents to speed up processing. If you’re not sure what to set, use one of the preset buttons.
Photoshop’s General preferences help you configure some of the more common features of the program. Color picker, image interpolation, and image Smart Object settings, as well as the History log, are set up in General preferences. Other options, such as beeping when an operation is finished, auto-updating open documents, and using the Shift key for tool switching, can all be turned on or off in the Options area. The Color Picker options allow you to select a color picker, either Adobe or the OS, and a HUD color picker (in 8-bit and 16-bit documents). The History Log lets you save all the History States performed on a particular document. For example, when you open an image, all the adjustments and actions performed are saved in a text file. This gives you access to valuable information, and lets you reproduce the steps performed on one image to correct another.

### Work with General Options

1. Click the **Edit** (Win) or **Photoshop** (Mac) menu, point to **Preferences**, and then click **General**.

2. Click the **Color Picker** list arrow, and then select Adobe or another operating system (Windows or Macintosh).

3. Click the **HUD Color Picker** list arrow, and then select a color picker style, such as Hue Strip or Hue Wheel.

4. Click the **Image Interpolation** list arrow, and then select Nearest Neighbor, Bilinear, Bicubic, Bicubic Smoother, Bicubic Sharper, and Bicubic Automatic.

5. Select the various options you want to use:
   - **Auto-Update Open Documents.** Creates a link between the open image and the image file on disk.
   - **Beep When Done.** Makes a sound when an operation is complete.
   - **Dynamic Color Sliders.** Previews color effects within the slider bars.
   - **Export Clipboard.** Transfers a copied image to the operating systems clipboard.
Use Shift Key For Tool Switch. Allows you to use the keyboard shortcut when two tools share the same slot in the toolbox.

Resize Image During Place. Allows you to resize an image during a Place.

Animated Zoom. Enables continuous-motion, smooth zooming in and out of your document, and Scrubby Zoom.

Zoom Resizes Windows. Forces the image window to resize when zoom is selected.

Zoom With Scroll Wheel. Determines whether zooming or scrolling is the default operation of the scroll wheel.

Zoom Clicked Point to Center. Centers the zoom view on the clicked location.

Enable Flick Panning. Enables quick mouse movement over the image instead of holding down the mouse.

Vary Round Brush Hardness based on HUD Vertical Movement. Enables brush variations (hardness and opacity) when vertically moving brush HUD.

Place or Drag Raster Images as Smart Objects. Converts raster images to Smart Objects when you place or drag them.

Snap Vector Tools and Transforms to Pixel Grid. Enables the snapping of vector tools and transformations to the pixel grid.

TROUBLE? Some options require the Use Graphics Processor option enabled in Performance Preferences to work; see details on page 75.

Select the History Log check box and then set the log options you want to use.

Click OK.

For Your Information

Resetting Photoshop Preferences

If your preference settings in Photoshop are causing display or performance problems, you can reset Photoshop preferences back to their defaults. To reset Photoshop preferences, press Shift+Ctrl+Alt (Win) or Shift+Option+ (Mac) immediately after you start Photoshop, and then click Yes to delete the Adobe Photoshop Settings File.
Setting File Handling Preferences

Work with File Handling Options

1. Click the Edit (Win) or Photoshop (Mac) menu, point to Preferences, and then click File Handling.
2. Select the File Saving Options you want to use:
   - **Image Previews.** Select from: Always Save, Never Save, or Ask When Saving.
   - **Icon.** Saves previews of the images (Mac).
   - **Windows Thumbnail.** Saves previews viewable when using the Win File Open command (Mac).
   - **Append File Extension.** Choose whether or not to append the file extension (Mac).
   - **Use Lower Case (Mac) or File Extension (Win).** Choose to have upper or lower case extensions.
   - **Save As To Original Folder.** Saves the file to original folder as the default.
   - **Save in Background.** Photoshop automatically saves in the background while you work.
   - **Automatically Save Recovery Information Every.** Saves document information for recovery based on an interval.

Sooner or later, you’ll have to save the file (document) you’ve created in Photoshop. Photoshop lets you save files using different formats, including TIFF, EPS, JPEG, or BMP. The File Handling preferences provide several options that modify what information is saved with a file. You can also set options to automatically save the file based on a time interval or save the file in the background, which allows you to keep working while Photoshop saves behind the scenes; a progress information appears in the Document tab and Status bar. If Photoshop crashes unexpectedly, the program automatically tries to recover and open your file. Image previews are typically very small, adding very little to the file size of the saved document. Once saved you may want to open, print, and possibly even modify the document using other image-editing applications. The File compatibility options help you use or save a file, including Camera Raw (New!), that will be transformed in Photoshop or transportable to other applications.
3 Select the File Compatibility options you want to use:

- **Camera Raw Preferences** Click to choose from options such as default image settings, cache size, DNG file handling, and whether or not to open JPEG and TIFF files with Camera Raw.

- **Prefer Adobe Camera Raw for Supported Raw Files.** Open supported raw files in Camera Raw.

- **Use Adobe Camera Raw to Convert Documents from 32 bit to 16/8 bit.** Converts 32-bit raw documents to 16/8-bit (New!).

- **Ignore EXIF Profile Tag.** Ignores color space metadata attached to digital camera images.

- **Ignore Rotation Metadata.** Ignore metadata attached to digital camera images.

- **Ask Before Saving Layered TIFF Files.** Lets you create multi-layered documents, and then save them using the TIFF format. This is a distinct advantage when you need to use multi-layered files and you don’t want to save them using Photoshop’s proprietary format (PSD).

- **Disable Compression of PSD and PSB Files.** Disables compression of files.

- **Maximize PSD and PSB File Compatibility.** Lets you save PSD files that can be opened in earlier versions of the program and PSB (Large Document Format) files.

4 Select the **Enable Adobe Drive** check box to enable Adobe Drive in your work process.

5 Enter the number of files (up to 30) to keep in the Recent File List box.

6 Click **OK**.
Working with Interface preferences gives you control over whether Photoshop displays or hides user interface features. You can change the user interface display by color theme or some elements by a selected color and border. For example, you can show the program window in four color themes in shades of gray or the Application icon in color or grayscale, show channels in color, or show selected menu items in user-defined colors. Interface preferences also allow you to use gestures with a tablet and pen, show descriptive labels when your cursor is placed over an option, automatically collapse icon panels when you click away, remember panel locations for the next use, and enable text drop shadows. You can also change the size of the text font on the Options bar, panels, and tool tips, restore all panels back to their default workspaces, as well as choose where to show transformation values.

Setting Interface Preferences

Work with Interface Options

1. Click the Edit (Win) or Photoshop (Mac) menu, point to Preferences, and then click Interface.
2. Select the Interface options:
   - **Color Theme.** Choose from four shades of gray. (Dark is default).
   - **Screen Modes.** Choose background and border colors for the three screen modes.
   - **Auto-Collapse Iconic Panels.** Automatically collapses icon panels when you click away.
   - **Auto-Show Hidden Panels.** Hidden panels will temporarily appear when you point to the edge of the application window.
   - **Open Documents as Tabs.** Opens documents in one window with tabs.
   - **Enable Floating Document Window Docking.** Allows floating document windows to dock when you move them.
   - **Show Channels In Color.** Allows you to view channels in the Channels panel in color.
   - **Show Menu Colors.** Displays menu items in user-defined colors.
◆ **Show Tool Tips.** Shows labels when your cursor is placed over an option.

◆ **Enable Gestures.** Allows the use of gestures with a tablet and pen.

◆ **Enable Text Drop Shadows.** Select to have text drop shadows on panel labels.

◆ **Show Transformation Values.** Select where to show transformation values near the cursor: Never, Top Left, Top Right, Bottom Left, or Bottom Right.

3 To restore all Photoshop panels back to their default workspaces, click **Restore Default Workspaces**.

4 Select the UI Text settings you want to use:

◆ **UI Language.** Choose a default language.

◆ **UI Font Size.** Choose a size for interface fonts.

5 Click **OK**.

---

**Did You Know?**

_You can turn a text box into a slider._

You can use any text box which displays a numerical value, such as font size, like a slider. Point to the name of the box (which changes the cursor to a hand with arrows), and then move the mouse left to decrease or right to increase the displayed number.
Photoshop’s Sync Settings preferences (New!) allows you to specify the settings you want to synchronize to an Adobe Creative Cloud account, which you can use on other computers with Photoshop. Creative Cloud is a membership-based cloud solution that allows you to access Adobe software, tools, services, personal files, tutorial videos, and sync program settings online from any computer or device. In order to sync program settings (New!) and access online content on Creative Cloud and Adobe.com, you’ll need to sign in to the service with your Adobe ID. If you’re not signed in when you start Photoshop, you’ll be asked to do so. When you’ve synced settings (New!) on Creative Cloud from another computer and there is a conflict, you’ll be asked if you want to sync settings (keep local or remote) to this computer.

**Change Sync Settings Preferences**

1. Click the **Edit** (Win) or **Photoshop** (Mac) menu, point to **Preferences**, and then click **Sync Settings**.
   - You can also click the **Edit** (Win) or **Photoshop** (Mac), point to **account address**, and then click **Manage Sync Settings**.

2. Select the **Sync Settings** check box to sync the settings you want or deselect to not sync any settings at all.

3. Select or deselect the Photoshop settings you do or don’t want to sync to the Creative Cloud.

4. Click the **When Conflict Occurs** list arrow, and then select an option to specify how you want to deal with sync conflicts.
   - **Ask My Preference**.
   - **Sync Local Settings**.
   - **Sync Cloud Settings**.
   - **Keep Latest File**.

5. Click **OK**.
Work with Sync Settings

1. When you start Photoshop and settings are synced with Creative Cloud from another computer, click Keep Local or Keep Remote to set sync settings (New!).

2. To sign in to your Creative Cloud account, click the Help menu, click Sign In, click Sign In Now, create an account or enter your account address. To sign out, click the Help menu, click Sign Out (account address), and then click Sign out.

3. Click the Edit (Win) or Photoshop (Mac) menu, and then point to account address.

4. Use any of the following:
   - Sync Settings Now. Syncs the settings to your Creative Cloud account based on your Sync Settings preferences.
     **TIMESAVER** Click the Sync Settings button on the Status bar, and then click Sync Settings Now.
   - Manage Sync Settings. Opens Sync Settings preferences.
   - Manage Creative Cloud Account. Opens your default web browser, displaying your Creative Cloud account, where you can make changes.

5. If a conflict occurs, click the Sync Settings button, and then click Keep Local or Keep Remote. If you want to remember it, select the Remember my choice check box.

See Also
See “Using the Status Bar” on page 30 for information on Sync Setting button on the Status bar.
We communicate with Photoshop using various devices, such as a drawing tablet, mouse, touch screen, track pad, or keyboard. Photoshop communicates with us using visual cues, the most prominent one being the shape of the cursor. For example, when a cursor looks like an I-beam, this typically means it’s time to enter text, or when the cursor looks like a magnifying glass, clicking on the image expands the view size. When you paint, you can specify how Photoshop displays the brush tip. Working with the Cursors preferences gives you control over how Photoshop communicates with you.

Setting Cursors Preferences

Work with Cursors Options

1. Click the Edit (Win) or Photoshop (Mac) menu, point to Preferences, and then click Cursors.
2. Select the Painting Cursors options you want to use:
   - **Standard.** Painting cursors look like their toolbox icons.
   - **Precise.** Painting cursors appear as crosshairs.
   - **Normal Brush Tip.** Painting cursors appear with the shape of the active brush tip.
   - **Full Size Brush Tip.** Shows the full size of the brush tip, including feathered edges.
   - **Show Crosshair In Brush Tip.** Displays a crosshair in the center of the brush tip.
   - **Show Only Crosshair While Painting.** Displays a crosshair while using a paint brush.
3. Select the Other Cursors options you want to use:
   - **Standard.** Painting cursors look like their toolbox icons.
   - **Precise.** Painting cursors appear as crosshairs.
   - **Brush Preview.** Choose a color for brush editing preview.
4. Click OK.

For Your Information

**Toggling Between Precise and Standard Tools**

Pressing the Caps Lock key while using a painting cursor toggles the tool between the precise and brush size options, and pressing the Caps Lock key when using any other cursor toggles between standard and precise options.
Transparency & Gamut preferences control how Photoshop displays transparent areas of a document (commonly called the checkerboard), as well as the color and opacity of areas of an image that fall outside of the CMYK (Cyan, Magenta, Yellow, and Black) color mode. It’s important to understand that transparency in Photoshop does not always translate into transparency after you save the file. For example, the JPEG format does not support transparency. When you save the file, Photoshop will fill the transparent areas of the image with a matte color (the default is white). In addition, the Gamut Warning may be activated because a monitor displays color information using RGB, and has more available saturation values than a CMYK document. Using a different ink or spot colors can sometimes fix an out-of-gamut color. For transparency it’s important to remember that unless you’re printing the document directly in Photoshop, it’s the format you choose that determines if the transparent areas will be saved, and the Gamut Warning is there to warn you of any areas that may not print the way you expect. To activate the gamut warning option, open a document, click the View menu, and then click Gamut Warning. Out-of-Gamut areas of the image will display with the color and opacity chosen in preferences.

**Control Transparency & Gamut Options**

1. Click the **Edit (Win) or Photoshop (Mac) menu, point to Preferences, and then click Transparency & Gamut.**
2. Select the Transparency Settings options you want to use:
   - **Grid Size.** Allows you to select a transparency grid size.
   - **Grid Colors.** Allows you to choose the color scheme for the transparency grid.
3. Select the Gamut Warning options you want to use:
   - **Color.** Choose a color to mask areas of an image that move out of the CMYK color space.
   - **Opacity.** Enter a value from 0% to 100%. Opacity determines how much of the Color Overlay masks the original image pixels.
4. Click **OK.**
While changing the measurable units and rulers do not affect output quality, they do help to measure information in a document consistent with the specific output device. Ruler Units give you precise information on the width and height of the active document. The Column Size measurements provide information that Photoshop needs to create documents with columns, such as newspapers, magazines, brochures, etc. The New Document Preset Resolutions area lets you select specific resolution values when creating new documents. Insert the values you'll use most often in the creation of a new Photoshop document.

Did You Know?

You can switch between ruler measurements without going to Preferences. To change the default measurement system of the Ruler bar, simply move into the Ruler bar, and then right-click your mouse. A list of available measurement options will be instantly available.
3 Select the Column Size settings you want to use:

- **Width.** Choose a measurement system and numerical value for column width.

- **Gutter.** Choose a measurement system and numerical value for gutter (the space between the columns).

When you choose a measurement system (points, inches, or centimeters), Photoshop changes the value to correspond to the type of measurement system.

4 Select the New Document Preset Resolutions settings you want to use:

- **Print Resolution.** Select a print resolution and measurement value for default printing.

- **Screen Resolution.** Select a print resolution and measurement value for default screen display.

5 Click the **PostScript** or **Traditional** option measuring systems for Photoshop’s type tool (PostScript is the most widely used).

6 Click **OK**.

---

**Did You Know?**

*You can choose what type of Point/Pica size to use.* Click PostScript (72 points/inch) or click Traditional (72.27 points/inch). PostScript is more widely used, and Photoshop defaults to this option.
Working with Guides, Grid & Slices

Work with Guides, Grid & Slices Options

1. Click the Edit (Win) or Photoshop (Mac) menu, point to Preferences, and then click Guides, Grid & Slices.

2. Select the Guides options you want to use:
   - **Color.** Select a default color for displaying guides.
   - **Style.** Select a default (Lines or Dashed Lines) for displaying guidelines.

3. Select the Smart Guides options you want to use:
   - **Color.** Select a color for use with Smart Guides.

Did You Know?

*You can change a horizontal guide into a vertical guide, and vice versa.* Move into the Ruler bar and drag a guide into the document window. Before releasing the mouse, hold down the Alt (Win) or Option (Mac) key. The guide automatically switches directions.

Guides, Grid & Slices preferences help keep a multi-layered document in proper order. For example, using Guides can help you line up buttons on a web interface, or make sure specific design elements are precisely placed within the document window. The Guides option lets you select the color and style of the guides placed within a Photoshop document. Guides are placed within the image by dragging them from the horizontal or vertical Ruler bars in the active document. The Grid options let you decide on a color, style, and layout for Photoshop’s grid system. The Slices option defines the visible color of a slice, and whether Photoshop displays a number value for each slice.
Select the Grid options you want to use:

- **Color.** Select a default color for displaying grids.
- **Style.** Select a default style (Lines, Dashed Lines, or Dots) for displaying the grid.
- **Gridline Every.** Enter a value for how often the grid lines appear within the active document.
- **Subdivisions.** Enter a value for how many subdivisions (lines) appear between each main gridline.

Select the Slices options you want to use:

- **Line Color.** Select a default line color for displaying document slices.
- **Show Slice Numbers.** Select the check box to display a number for each slice in the upper left corner of the slice.

**IMPORTANT** When you select a line color, choose a color that is different than the grid and guide line colors. That way you can easily identify grids and guides for user-created lines.

Click **OK**.

**Did You Know?**

*You can change color choices for Guides, Grid & Slices.* Not satisfied with the color choices offered by the color and style menus? Click on the Color boxes located on the right side of the Preferences dialog box, and select any color from the Color Picker.
A plug-in is an external code modal that extends the functionality of a program. Photoshop comes with several installed plug-ins, such as Camera Raw and Filter Gallery; however, you can install other third-party ones too. If you want to use third-party plug-ins, you’ll need to place or install them (unless specified by the developer) in the default Photoshop Plug-ins folder—located in the main Adobe Photoshop folder—in order to make them available in Photoshop; the Additional Plug-ins Folder is no longer available. Plug-ins preferences allows you to specify options relating to plug-ins, filters, or extension panels. For filters, you can specify whether you want to show all Filter Gallery groups and names on the Filter menu. For extension panels, you can specify whether to allow extensions to connect to the Internet and load extension panels for use on the Extensions submenu on the Window menu.

Work with Plug-Ins Options

1. Click the Edit (Win) or Photoshop (Mac) menu, point to Preferences, and then click Plug-Ins.
2. Select the Show all Filter Gallery groups and names check box to display all Filter Gallery groups and names on the Filter menu.
3. Select the Extension Panels options you want to use:
   - Allow Extensions to Connect to the Internet. Select to allow all extensions to connect to sites on the Internet.
   - Load Extension Panels. Select to load extension panels, such as Kuler and Adobe Exchange, which become available on the Extensions submenu on the Window menu.
4. Click OK.

Did You Know?

You can find out about installed plug-ins. Click the Help (Win) or Photoshop (Mac) menu, point to About Plug-ins, and then select a plug-in to find out about it.
Chapter 3 Customizing the Way You Work

Selecting Scratch Disks

Work with Scratch Disks Options

1. Click the Edit (Win) or Photoshop (Mac) menu, point to Preferences, and then click Performance.

2. Select the check box next to the scratch disk you want to use or clear the check box to remove it.

   IMPORTANT Photoshop holds scratch disk space as long as the application is open. To delete scratch disk space you must close Photoshop.

3. Click OK.

Performance preferences are available to help you get the best performance out of your computer by letting you choose one or more hard drives for scratch operations. When your computer doesn’t have enough RAM to perform an operation, Photoshop uses free space on any available drive, known as a Scratch Disk. Photoshop runs faster when you divide the Scratch Disk workload. Scratch operations are performed on your hard drive and take place when Photoshop is using one of its many filters and adjustments. Photoshop detects and displays all available disks in the Performance preferences dialog box, where you can select the disks you want to use. By assigning additional hard drives to the task, you speed up Photoshop’s overall performance. Scratch Disk changes take effect the next time you start Photoshop.
Memory Usage and History & Cache preferences give you control over how much RAM is assigned to Photoshop, and how much memory is allocated to screen redraws (Image Cache). Photoshop, being a high-performance application, requires a fairly large amount of RAM. Photoshop uses many operations that affect RAM: History States, Undo, Clipboard, and Cache. Cache Levels are screen redraws, or how many versions of the current active document Photoshop saves. When you’re working on large documents, more Cache Levels help speed up the redraw function, and make image manipulation proceed faster. However, they are held primarily in RAM, so the more Cache Levels you choose, the less RAM is available for other Photoshop functions. Cache Tiles are the amount of data Photoshop stores or processes at once; use a larger tile size for larger documents to speed up processing. If you’re not sure what to set, use one of the preset buttons. By fine-tuning Photoshop’s engine, you increase its overall speed, and you’ll get more design miles to the gallon.

Allocate Memory & Image Cache Options

1. Click the Edit (Win) or Photoshop (Mac) menu, point to Preferences, and then click Performance.

2. Select the History & Cache options you want to use:
   - **Optimize.** Click a button to use a preset cache level.
   - **Tall and Thin.** Use for small documents and many layers (dozens to hundreds).
   - **Default.** Use for general use.
   - **Big and Flat.** Use for large documents (hundreds of megapixels) with few layers.
   - **History States.** Enter the amount of History States steps you want to keep as undos; you can enter up to 1,000. The more History States used, the more RAM is required, which impacts performance.
   - **Cache Levels.** Select a number from 1 to 8. Set to 2 or more for optimum GPU performance.
◆ **Cache Title Size.** Specify a size for the amount of data Photoshop stores or processes at once. Use a large amount for large documents to maintain a good processing speed.

3 Enter the percentage of RAM used in the Let Photoshop Use box.

Photoshop needs about 5 times the size of the open document of unused RAM to operate efficiently.

**IMPORTANT** Never select upwards of 100% Memory Usage for Photoshop, leaving little for the operating system or any other open programs. Any changes made for allocating memory and image caching will take place the next time you start Photoshop.

4 If you have a video card installed, the video card name appears. Select the **Use Graphics Processor** check box (which uses OpenGL) to use the enhanced speed and smoothness of graphic/3D rendering and navigation. Click **Advanced Settings** to select additional options:

◆ **Drawing Mode.** Select a mode (Basic, Normal, or Advanced) to use different amounts of memory processing.

◆ **Use Graphics Processor to Accelerate Computation.** Select to access available GPU power to speed up computation.

◆ **Use OpenCL.** Select to access available parallel processing power; uses the GPU to accelerate filter performance.

◆ **Anti-alias Guides and Paths.** Select to enable anti-alias smoothing for better display with GPU hardware.

5 Click **OK**.

---

### Supporting the Graphics Processor

Some features in Photoshop require a video card processor, or **GPU** (Graphics Processing Unit), and some VRAM memory (typically 512 MB) for better performance or to function at all. The GPU features includes many filters, 3D, Scrubby Zoom, Animated Zoom, Flick-panning, Rule of thirds crop grid overlay, Rotate the canvas, Adobe Color Engine (ACE), and pixel grid to name a few. The GPU uses **OpenGL** (Open Graphics Library) to render and accelerate 2D and 3D graphics and **OpenCL** (Open Computing Language) for parallel processing acceleration. Along with the GPU, Photoshop uses the Adobe **Mercury Graphics Engine** (MGE), which provides near instant results when working with Liquify, Warp, Lighting Effects, and Oil Paint filters.

When you start Photoshop, it runs the **GPU Sniffer** to check for problems. If a problem occurs, the GPU is turned off and a warning dialog box appears, providing status and correction details. If you have problems with the GPU, update your display drivers or replace your video card. If problems still exist, turn off OpenGL, which is deselecting the Use Graphics Processor check box in Performance preferences. You can also try resetting preferences; see details on page 59.
Although Photoshop is not by definition a typesetting application, such as Adobe InDesign, it does have some very powerful type features. For example, Adobe Photoshop allows you to output PostScript text to a printer with a PostScript option. This way you will not need to place Photoshop images into type-intensive applications, such as InDesign or Illustrator, just to create a few lines of text. In addition, Photoshop’s type menu lets you see fonts exactly as they will print or display. For designers who use a lot of fonts, this WYSIWYG (What You See Is What You Get) font menu is a timesaver. You can use Type preferences to help you select the type and font options you want to use.

### Setting Type Preferences

#### Work with Type Options

1. Click the **Edit** (Win) or **Photoshop** (Mac) menu, point to **Preferences**, and then click **Type**.

2. Select the Type options you want to use:

   - **Use Smart Quotes.** Select to use left and right quotation marks.

   - **Enable Missing Glyph Protection.** Select to automatically select incorrect, unreadable characters between roman and non-roman (Japanese or Cyrillic) fonts.

   - **Show Font Names In English.** Select to display non-roman fonts using their roman names.

   - **Choose Text Engine Options.** Select to display East Asian or Middle Eastern.

3. Click **OK**.

### IMPORTANT

Photoshop uses PostScript measuring systems to size fonts. Therefore a 72-point font will print 1 inch tall. This lets you know how big the fonts will appear when output to print.
Managing Libraries with the Preset Manager

Create a New Preset

1. Click the Edit menu, point to Presets, and then click Preset Manager.
   - To migrate presets from earlier Photoshop CS versions, click the Edit menu, point to Presets, and then click Migrate Presets.

2. Click the Preset Type list arrow, and then select the options.

3. Click the Options list arrow, and then select from the available presets to add them to the current item list.

4. To remove any items in a new preset, click a thumbnail, and then click Delete.

5. To reorganize their order, click and drag the thumbnails to new positions within the view window.

6. To change a preset name, click a thumbnail, click Rename, change the name, and then click OK.

7. Click one or more thumbnails (Ctrl+click (Win) or ⌘+click (Mac), and then click Save Set.

8. Enter a new set name, and then select a location to store the set. The set is saved with the ABR extension.

9. Click Save, and then click Done.

For Your Information

Importing and Exporting Presets

You can migrate your presets from previous versions of Photoshop or import/export them for backup purposes or to share with others. When you start Photoshop for the first time, it will ask you whether you want to migrate presets. If you decline, you can still do it; click the Edit menu, point to Presets, and then click Migrate Presets. To import or export presets, click the Edit menu, point to Presets, and then click Export/Import Presets. In the Export/Import dialog box, select the Export Presets or Import Presets tab. For export, select your presets (left column), move the presets to export (right column), and then click Export Presets (select location, and then click Open). For import, click Select Import Folder (select it, and then click Open), select source presets, move the presets to import (right column), and then click Import Presets.
The Photoshop workspace consists of a document surrounded by an Application frame (Mac only), Options bar, toolbox, and over 20 floating panels. Depending on how you work, your workspace may reflect any combination of the above. For example, when you work with text, you would need the Character and Paragraph panels, but you might not need the Styles or Histogram panel. Rather than making you redesign your workspace every time you begin a new project, Photoshop gives you ways to use predefined workspaces or create your own customized workspaces. Photoshop includes predefined workspaces including Essentials (Default), What’s New, 3D, Motion, Painting, Photography, and Typography. If you’re curious about all the new features in Photoshop CC, you can choose a drop-down menu system with all the new features highlighted. You can access workspaces by using the Workspaces menu on the right side of the Options bar or the Workspace submenu on the Window menu. When you create or change a workspace, Photoshop auto-saves any changes (even if you exit Photoshop) until you reset it.

**Display a Workspace**

1. Click the Workspaces menu on the Options bar, or click the Window menu, and then point to Workspace.

2. Select a panel option:
   - Custom panel name. Displays a custom panel layout that you created.
   - Essentials (Default), What’s New, 3D, Motion, Painting, Photography, or Typography. Displays panel layouts created by Adobe for specific purposes in Photoshop.

**Did You Know?**

You can reset a workspace. You can reset a workspace to its original configurations. Select the workspace, click the Workspace menu or click the Window menu, point to Workspace, and then click Reset workspace name.
Create a Customized Workspace

1. Arrange the panels into a specific working order.
2. Click the Workspaces menu on the Options bar, or click the Window menu, and then point to Workspace.
3. Type a name for the workspace.
4. Select check boxes to save Keyboard Shortcuts or Menus.
5. Click Save.

Delete a Customized Workspace

1. Click the Workspaces menu on the Options bar, or click the Window menu, and then point to Workspace.
2. Click the Workspace list arrow, and then click the workspace you want to delete, or click All Custom Workspaces.
   - You cannot delete the current workspace. You must switch to another workspace first.
3. Click Delete, and then click Yes to confirm the deletion.

For Your Information

Working with the Application Frame

The Application frame is the Photoshop window that groups all the workspace elements into a single window. When you move or resize the Application frame, all the workspace elements within it change so nothing overlaps. This allows you to position the Photoshop window and other application windows side by side, so you can work together on the same screen or on multiple monitors. If you prefer to use the traditional Mac user interface, you can turn off the Application frame. Click the Window menu, and then click Application Frame to turn it off or on (Mac only).

See Also

See “Setting Interface Preferences” on page 62 for more information on resetting all Photoshop panels back to their original settings.
Building Specialized Workspaces

Build a Specialized Workspace with Configurator

1. Start Adobe Configurator 3.0 or later from the Start menu or screen (Win) or the Applications folder (Mac).
2. Click the File menu, and then click New Panel.
3. Click the Select Product list arrow, and then click Photoshop CC or InDesign CC.
4. Click OK.
5. Use the controls on the right to enter a panel name, and customize the layout and functionality.
6. Drag the items you want to add to your panel from the left pane to the new panel.
7. To save the panel file (GPC), click the File menu, and then click Save Panel As. Enter a name, specify a location, and then click Save.
8. Click the File menu, and then click Export. Specify the location of the Plug-In Panels folder (the default), click Select, and then click OK.
9. Click the File menu, and then click Exit.
10. In Photoshop or InDesign, click the Window menu, point to Extensions, and then select your new panel. Restart Photoshop or InDesign after exporting your panel for the first time.

If you want to build a specialized workspace with custom panels in Photoshop, you can use the Adobe Configurator panel utility. The external program is available as a separate download from Adobe at www.labs.adobe.com. With Configurator, you can drag and drop tools, menu items, scripts, actions, and other objects into a panel to build a specialized workspace design. In addition, you can access anything on the web, such as blogs, videos, or e-mail, with these specialized designs that leverage built-in Flash support. When you’re done creating a design, you can export it for use in Photoshop or InDesign.
Photoshop’s pull-down menus actually contain hundreds of options (yes, I did say hundreds). If you find navigating through menus a hassle, then Adobe has the answer to your problem with a customizable user interface. In Photoshop, you have the ability to choose what menu items appear on the pull-down menus and you can even colorize certain menu items for easier visibility. If you no longer want to use a customized set, you can delete it and restore Photoshop back to the default.

Creating a Customized User Interface

Create and Work with a Customized User Interface

1. Click the Window menu, point to Workspace, and then click Keyboard Shortcuts & Menus.
2. Click the Menus tab.
3. To create a new set based on the current active set, click the Create a New Set button, enter a name, and then click Save.
4. Click the Set list arrow, and then select a listing of modified User Interfaces.
   - **Delete Set.** Select the set, and then click the Delete button.
   - **Restore Original Set.** Select the Photoshop Default set.
5. Click the Menu For list arrow, and then click Application Menus or Panel Menus with the items you want to modify.
6. Click an arrow (left column) to expand the menu that contains the command you want to modify.
7. Click the Visibility icon associated with a command to show or hide the command.
8. Click the Color list arrow, and select a color for the selected command.
9. Click the Save All Changes button to save the new customized User Interface.
10. Click OK.

![Image of the customizing interface in Photoshop with numbers indicating steps 1-10]
A wise man once wrote “time is money,” and Photoshop is a program that can consume a lot of time. That’s why the Photoshop application uses keyboard shortcuts. **Keyboard Shortcuts**, as their name implies, let you perform tasks in a shorter period of time. For example, if you want to open a new document in Photoshop, you can click the File menu, and then click New, or you can abandon the mouse and press Ctrl+N (Win) or ⌘+N (Mac) to use shortcut keys. Using shortcut keys reduces the use of the mouse and speeds up operations. In fact, a recent study in the American Medical Journal suggested that the use of shortcut keys significantly cuts down on repetitive stress, and reduces instances of carpal tunnel syndrome. Photoshop raises the bar by not only giving you hundreds of possible shortcut keys, but also actually allowing you to define your own shortcuts.

### Did You Know?

*You can save time using shortcut keys.*

According to several time and motion studies, using shortcut keys can actually save a computer user 1 hour out of every 8 in a work day.

### Working with Shortcuts

In addition to adding shortcuts, you can delete any of them you don’t want and even print out a summary of shortcuts defined in Photoshop. Shortcuts can be used for the Application and Panel menus, as well as for your tools in the toolbox. Click the Edit menu, click Keyboard Shortcuts, and then use the appropriate buttons, such as Add Shortcut, Delete Shortcut, or Summarize, to perform the tasks you want.
This page intentionally left blank
A

absolute colorimetric rendering intent, 469
accented edges filter effect, 391
Acrobat 4 color system, 472
actions, 393-414. See also droplets
  adding command to action, 400
  buttons, converting to, 395
  conditional, insert, 394, 406
  Conditional Mode Change command, 446
  copying, 404
    sets, copying between, 408
  deleting command from action, 401
  enhanced scripting of, 411
  files, saving actions as, 410
  modal controls, working with, 402
  moving actions between sets, 408
  multiple sources, calling actions from, 405
  names for action sets, 408
  new action, building, 396
  non-recordable commands, inserting, 407
  order of commands, changing, 403
  pauses in, 402
  play options, 412
  playback of command, controlling, 399
  recording actions, 397
  running actions inside actions, 405
  running scripts, 411
  saving, 393
    files, saving actions as, 410
    sets, saving actions into, 409
  sets
    creating, 409
    files, saving actions as, 410
    moving and copying between, 408
    names for, 408
    speed of executing, 403
    stop to action, adding, 398
Actions dialog box, 410
Actions panel, 393-395. See also actions
Adaptive Wide Angle filter, 372-373
Add Layer Mask button, 263, 265
  with type masks, 353
Add Layer Styles button, 265, 307, 322
Add New Layer button, 117
Add Noise filter, 166
Additive RGB, 196
adjustment layers, 115
  advantages of, 155
  blending modes with, 162
  composite layers, creating, 159
  creating, 156
  deleting, 161
  file formats for, 156
  filters on masks, 165
  grouping, 160
  HDR Toning, 226-227
  Levels adjustment for, 188-189
  linking layers in, 131, 159
  masks with, 164-165
  merging, 158-159
  modifying, 157
  opacity, working with, 162
  pain on adjustment masks, 164
  regular layer, converting to, 161
  temporary composite images, 159
Adobe (ACE) color management, 75, 476
Adobe Acrobat Reader, 4
Adobe Application Manager, 4, 24-25, 546
Adobe Bridge. See Bridge
Adobe Creative Cloud, 1, 543-544
  Adobe ID, 1-5, 25-26, 563-564
  sign in and out, 4-5, 25, 564
  sync settings to, 30, 64-65
Adobe Drive, 28, 30
Adobe Exchange panel, 544, 563
Adobe Extension Manager, 544, 562, 563
Adobe ExtendScript Toolkit 544, 559
Adobe Flash. See SWF files
Adobe Gamma utility, 464
Adobe Help Center, 4, 26-27
Adobe ID, 1-5, 25-26, 563-564
Adobe Illustrator. See Illustrator
Adobe Media Encoder, 544, 560-561
Adobe Mercury Graphics Engine (MGE), 75
Adobe Updater Preferences dialog box, 4, 24-25
Airbrush, 183, 237, 241
align layers, Auto, 132-133
alpha channels
different file formats, saving as, 429
saving, 28
altitude values for Bevel and Emboss style, 311
anchor points. See also paths
with Magnetic Lasso tool, 89
Android, 560-561
angle values
for Bevel and Emboss style, 311
for Drop Shadow style, 308
with Smart Sharpen filter, 178
animations, work with, 524-525
animated GIFs
creating, 522-523
annotations. See notes
anti-aliasing
for Bevel and Emboss style, 312
Character panel selections, 333
Column Marquee tools and, 86
with Custom Shapes tool, 247
for Drop Shadow style, 309
for Inner Glow style, 321
with Line tool, 245
and Magic Eraser tool, 256
multi-page PDFs to PSDs, converting, 449
for Outer Glow style, 319
with Paint Bucket tool, 253
for paths with fill, 300
setting options for, 335
with Type tool, 329, 331
Apple Computers. See also Macintosh
Apple Devices
Media Encoder for, 560-561
AppleScript, 411
Application frame, 78-79
Arc and Arch styles of warped text, 336
arrange multiple documents, 42
arrowheads with Line tool, 245
Art History brush, 141, 152
artistic filters, 356
for layer mask borders, 267
Asian text options, 76
audio, adding to a video layer, 521
Auto-Align, 132-133
Auto-Blend, 132-133
Auto Color command, 213
Auto Contrast and Color command, 213
Auto Contrast command, 213
Auto Erase, 244
Auto Save, 28-29, 60-61
Auto Tone command, 212
Auto levels command, 214
Automate commands, 443-462
B
Background Eraser tool, 254-255
backgrounds, 115, 232-233
converting into layers, 122-123
default and switching of colors, 233
Foreground and Background colors, 232-233
Merge Visible option, 123
multi-layered documents into backgrounds, converting, 123
Screen Mode determining, 37
Barrel distortion, 170-171
baseline shift, 327
Character panel selections, 333
batch commands with Bridge, 460-461
Batch File Processing, 444-445
BBEdit, 411
Behance, sharing on, 442
Status bar, 30
Bevel and Emboss style
contours, working with, 311-312
with layer masks, 265
Texture option for, 312-313
with type masks, 350-351
working with, 310-311
Bicubic Sharper method, 22, 58
Bicubic Smoother method, 22, 58
Bilinear method, 22, 58
Bird’s Eye view, 38-39
bit depth, 192
bitmap color modes, 195, 199
bitmapped fonts, 331
black and white. See also Grayscale color mode
   Threshold adjustment for, 225
   Black & White adjustment, 229
Black Point Compensation
   for converting color space, 477
   for soft-proof colors, 466
blade curvature with Lens Blur filter option, 379
blend modes, 09
   with adjustment layers, 162
   Color Overlay style with, 314
   for Drop Shadow style, 308
   Fill blending mode, 211
   with filter effects, 381
   for Inner Shadow style, 320
   with layer masks, 267
   with layers, 135
   for Outer Glow style, 318
   with Pattern Overlays, 316
   for Stroke layer style, 315
blend layers, Auto, 132-133
bloating with Liquify, 360
Blur filters. See also Lens Blur filter
   Box Blur filter, 172
   channel masks, softening effects of, 279
   Field blur filter, 376-377
   Gallery, 376-377
   Iris blur filter, 376-377
   in Quick Mask Mode, 283
   Shape Blur filter, 172-173
   Surface Blur filter, 172-173
   Tilt-Shift blur filter, 376-377
Blur tool, 180
BMP files, 427
   layers exported as, 138
borders
   Auto Color command with, 213
   channel mask borders, moving, 280
   layer mask borders, creating, 267
paths, creating shapes as, 302
boundaries, proportional transform, 102
bounding boxes, 267
   clipping paths and, 298
   in Print dialog box with preview, 416-417
Box Blur filter, 172
Bridge, 1, 4
   adjustments, images, 556
   automating, tasks, 557
   camera raw, 548-551
   closing documents and opening, 31
   exploring, 545
   images, working with, 552-553
   Mini Bridge, 558
   opening files with, 16
   photos, getting, 547
   preferences, 554-555
   starting, 546
   with Adobe Creative Cloud, 2, 13, 473
   Web Photo Gallery, 553
brightness. See also HSB (hue, saturation, brightness)
   with Lens Blur filter, 379
Brightness/Contrast adjustment, 191, 216-217
Bristle brush tip
   adjusting, 238
Brush font, 318
Brush Pose, 234, 237
brush strokes filters, 356
   in Quick Mask Mode, 283
brush tips, 236
   cursor options, 66
   customized brush tips, creating, 239
   saving, 240
brushes, 231. See also specific tools
   with Color Replacement tool, 260
   Liquify tool option, 362
   in Quick Mask Mode, 282
   with Vanishing Point tool, 168
Brush Options menu, 240
Brush panel, 234
   Bristle brush tip, adjusting, 238
   Brush tip, adjusting, 237
   pre-defined sets in, 236
Brush Presets panel, 234
   modifying, 235
   built-in scripts, 411
Build-up, brush, 234, 237
Bulge style of warped text, 336
Burn tool, 183

C

cache preferences, 57
  setting levels, 74
calibrating colors. See color management
calligraphy lettering, Pencil tool for, 243
camera Data 1 and 2, 430
camera Raw
  dialog box, 18-19, 548-551
  introduction, plug-in, 544
  filter, using, 368
  preferences in Bridge, 548
  preferences in Photoshop, 61
Radial filter, 370, 550-551
Spot Removal filter, 371, 550-551
Upright filter, 369, 550-551
canvas size, 22-23
center justification, 331
chain button with layer masks, 263
channel masks, 261. See also quick mask mode
  combining, 281
  deleting, 278-279
  filter effects, controlling, 386-387
Gaussian Blur filter with, 279, 281
loading, 278-279
modifying options, 274
moving masks between documents, 280
  from native color channels, 276-277
  pre-existing channels, options, 274
  saving, 278-279
  from scratch, 273
  from selections, 275
  showing/hiding, 273
  softening effects of, 279
  working with, 272
channel mixer adjustment, 221
channels, 191. See also channel masks
  Channel Mixer adjustment, 221
  8-bit channels, 192-193
  Spot color channels, 212
channels panel. See also channel masks
  selections, creating, 100
  working with, 194

character panel, 78-79, 327
  showing/hiding, 331
character panel
  working with, 332-333
character styles panel
  creating styles, 338-339
chisel hard technique for bevel, 310
chiseled text
  creating, 320
  with type mask, 350-351
choke value for inner glow style, 321
chromatic aberration, 170
circles with standard shape tool, 246, 248-249
clipart for Web, preparing, 434-435
clipboard
  with pattern maker filter, 382
  preferences for, 59
clipping. See also paths
  masks, creating, 117
clone stamp tool, 181, 519
clone source panel, 181, 184, 186, 519
closing documents, 31
CMYK (cyan, magenta, yellow, black) color,
  13, 47, 195. See also color management; out-of-gamut
color slider, 206
converting images to, 197
multi-channel color mode, converting images to, 204
patterns, generation of, 383
press, preparing images for, 438-439
RGB (red, green, blue) color and, 195, 468
sof-proof colors, setting up, 466-467
spectrums or ramps, 207
color balance command, 191, 216-217
color dynamics, 234, 237
color handling, printing, 420-421
color intensity with match color adjustment, 230
color lookup table (CLUT), 200-201
color management, 463-481. See also ICC profile; out-of-gamut
  assigning profiles to document; rendering intent
  defaults, 472-473
  hardware, calibrating with, 465
monitors, calibrating, 464
Print dialog, options, 420-421, 470-471
RGB to CMYK, changing from, 468
soft-proof colors, setting up, 466-467
software, calibrating with, 465
working with, 472-473
Color Management, printing, 420-421
color markers, creating, 46
color modes, 13, 195
bitmap color modes, 199
changing, 195
Replace Color command, 205
selecting, 13
Color Overlay, 305
applying, 314
Color panel, 206-207
for PNG-8 documents, 494
Color Picker, 58-59
selecting colors from, 206-207, 232-233
text color, changing, 329
Color Replacement tool, 260
color sliders, 206
preferences for, 59
Color Sampler Tool, 46, 233
Color Swatch button, 331
colors, 191. See also channels; CMYK (cyan, magenta, yellow, black) color; color management; Info panel; RGB (red, green, blue) color; spot colors; tonal values; unified color table
Auto Color command, 213
Auto Contrast command, 213
Auto levels command, 214
Background colors, 232-233
Background Eraser tool, 254-255
of brush tips, 239
Black & White adjustment, 229
Channel Mixer adjustment, 221
clipart for Web, preparing, 434
Color Balance adjustment, 216-217
Color Range, 93, 478-479
Color Replacement tool, 260
Curves adjustment, 216
deleting on Swatches panel, 208
Desaturate command, 218
for Drop Shadow style, 308
Equalize command, 224
Eraser tools with, 254-255
Exposure adjustment, 215
fill colors, changing, 346
Fill command, 210-211
Foreground colors, 232-233
for GIF documents, 492
Gradient Map adjustment, 222
Grid options, 70-71
Guides option, 70-71
for Inner Glow style, 320
Invert command for, 224
levels adjustment, 214
Macintosh, printing in, 422-423
Match Color adjustment, 230
Navigator panel view box color, 36
of notes, 45
for Outer Glow style, 318
Photo Filter option, 223, 380
for PNG-8 documents, 494
Posterize adjustment for, 225
in Quick Mask Mode, 283
Replace Color command, 205
selection by color range, 93
Selective Color adjustment, 220
skin tones, detect faces, 93
Slice option, 70-71
Stroke command, 210
Swatches panel, 208-209
text color, changing, 329
for transparency grid, 67
Color Range, 93, 478-479
ColorSync, 464, 476
workflow, setting, 472
color settings, 472
with Creative Cloud, 473
columns and rows
ruler options, 69
Single Row/Column Marquee tools, 86
combine layers, Auto, 132-133
combining channel masks, 281
commands. See also specific commands
built-in or custom scripts, 411
compression. See file compression
combs, layer, 137
concavity with Line tool, 245
conditional action, 384, 406
Conditional Mode Change command, 446
Contact Sheet, creating, 452-453
Content-Aware fill, 108-109
  with Patch tool, 110
Content-Aware move and extend, 111
  Content-Aware Move tool, 10, 111
Content-Aware scaling, 107
contours
  for Bevel and Emboss style, 310
  for Outer Glow style, 319
  working with, 312
Convert Point tool, 297
Convert To Mask button, 272
Convert To Profile command, 476
copies
  different file formats, save as, 429
  file copies, saving, 28
  printing, 416, 422, 424
copying. See also actions; layers
  do not copy watermarks, 389
History states, 142, 147
  selection, 99, 127
  with Vanishing Point tool, 168-169
copyrights, watermarks protecting, 355, 388-389, 430-431
contours
  for Drop Shadow style, 309
  for Inner Glow style, 321
Count tool, 52-53
crawling marquee, 286
Create New Action button, Actions panel, 394-395, 396
Create New Channel button, 272
Create New Layer button, 267
duplicating layers with, 128
Create New Set button, Actions panel, 395
Create Plane tool, 168
Crop and Straighten Photos command, 447
Crop command, 102
crop marks, printing, 418
cropping selections, 104-106
  two images at the same time, 104
Crop Tool, 104-105
  Perspective Crop Tool, 106
CSS (Cascading Style Sheets)
  copying from layers, 139
  importing color swatch from, 208-209
cursors
  painting cursor options, 66
preferences, 66
Curves adjustment, 191, 216
  with channel masks, 277
custom preset document, creating, 12
Custom Shapes tool, 247-252
  creating custom shapes, 251
  saving shape sets, 252
customizing, 55. See also layer styles
  brush tips, 239
  color settings, 472-473
  Swatches panels, 209
user interface, 62-63, 80-81
  workspace, 78-79
cutout filter effect, 390

D
data driven graphics, 508
DCS files, 427
  press, preparing images for, 438-439
defaults for panels, 7-9
default type styles, 341
Delete button, Actions panel, 395
deleting. See also layers
  actions, commands from, 401
  adjustment layers, 161
  anchor points in paths, 292-293
  with Bridge, 552-553
  channel masks, 278-279
  customized workspace, 78-79
  linked layers, 129
  notes, 45
  panels, 7-9
  pixels, 44
  presets, items in, 77
  ruler guides, 49
  Swatches panel, colors on, 208
text, 329
density option, 423, 390
depth values
  for Bevel and Emboss style, 310
  Lens Blur filter option, 379
  for texture, 313
Desaturate command, 218
Despeckle filter, 174
destination for droplets, 413
DICOM files, 427
Diffusion Smudge filter, 354
Difference Blending Mode, 162
diffuse glow filter effect, 391
digital cameras
calibrating, 465
importing raw data from, 18-19
noise from, 167
digital watermarks, embedding, 355, 388-389
Direct Selection tool, 295
curve of segment line, changing, 297
type path, reshaping, 354
direction for Bevel and Emboss style, 310
Display preferences. See also interface
distance values
for Drop Shadow style, 309
Lens Blur filter option, 379
distortion, 356
with Free Transform command, 102
for layer mask borders, 267
Lens Correction filter and, 170-171
in Quick Mask Mode, 283
Transform command selection, 103
distribution option with Add Noise filter, 166
dithering
clipart for Web, preparing, 434
for GIF documents, 493
for gradients, 257
for Indexed color mode, 200
for PNG-8 documents, 495
for WBMP documents, 469
DNG files
information on, 551
raw images saved as, 18-19, 548-551
do not copy watermarks, 389
Dock, painting engine in, 234
docking, 6
document windows, 42
document dimensions, 30
document window, 6
moving images in, 41
Vanishing point tool, working with, 168-169
documents. See also layers; new documents
all documents, closing, 31
backgrounds, converting multi-layered documents into, 123
closing, 31
custom preset document, creating, 12
dragging layer thumbnails into documents, 44
inserting, images, 17
file information into, 430-431
New Document Preset Resolutions, 68-69
multiple, arrange, 42
organizing documents, 429
profiles, 30
saving, 28-29
sizes, 30
Dodge tool, 183
downloading
DNG converters, 19
layer styles, 324
patches, 24-25
updates, 24-25
dragging layer thumbnails into documents, 44
Drawing tool, 231
Drop Shadow, 306
creating, 308-309
with layer masks, 265
modifying, 308-309
droplets, 393
creating, 412-413
naming options, 413
using, 414
dry brush filter effect, 390
DSC 2.0 color plates, 212
Dual Brush, 234, 237
Duotone color mode, 195
converting images to, 203
duplicating. See copying
Dust and Scratches filter, 166
dynamic range, 192-193. See also High Dynamic Range (HDR) images
E
East Asian
language options, 329
Edit Plane tool, 290
editing
animated GIFs, 499
inserted documents, 17
nondestructively, 21
selections, 98
8-bit channels, 192-193
   Exposure adjustment with, 215
ellipses
   for layer mask borders, 267
   with Standard Shape tool, 246, 248-249
Elliptical Marquee tool, 85
Embed Color Profile, Macintosh, 429
embedding
   ICC color profiles, 474
   for JPEG images, 491
   for PNG images, 494-496
   proof profile information, 29
Emboss style. See Bevel and Emboss style
emulating color systems, 472
Enable GPU (Graphics Processing Unit), 74-75, 530-531
encoding images for press, 439
EPS files, 427
   inserting images in, 17
   metadata information, adding, 431
   text saved as, 337
Equalize command, 224
Eraser tools, 231, 254-255
   Background Eraser tool, 254-255
   basic Eraser tool, 254
   with Foreground and Background colors, 232
   to History brush, 153
   Magic Eraser tool, 256
exact colors for Indexed color mode, 200
Exclusion Blending Mode, 162
EXIF profile tag, ignoring, 61
exiting Photoshop, 32
Export Layers To Files command, 138
exporting. See importing and exporting
exposure
   controlling, 30
   Exposure adjustment, 215
Extension Manager, 562
Extract, 355
eyedroppers, 93
   for Background colors, 232-233
   for Foreground colors, 232-233
   with Save For Web command, 486
   for 3D models, 539
   with Vanishing Point tool, 169
F
   F-Stop information, 430
   Face detection, 93
   fades, 355
      with Match Color adjustment, 230
      with Smart Sharpen filter, 179
      working with, 384
   Feather option
      with layer masks, 266
      for out-of-gamut colors, 479
   Field blur filter, 376-377
   File Compatibility options, 28-29, 61
   file compression
      lossy/lossless compression, 432
      understanding, 432
   file extensions
      for droplets, 413
      lowercase, saving as, 29
   file formats. See also specific types
      different file formats, saving documents with, 428-429
      list of, 427
      understanding types of, 427
   File Handling preferences, 55, 60-61
files. See also droplets; importing and exporting
   3D, 530-542
   actions as files, saving, 410
   File Handling preferences, 60-61
   Fill command, 210-211
      Content-Aware fill, 108-109
      for paths, 285
      with paths, 300
   fills
      colors, changing, 346
      Layers panel option, 114
      with Paint Bucket tool, 253
      for Stroke layer style, 315
   Filter Controls, Image Gallery dialog box, 356
   Filter Gallery, 356-357
      multiple filters, applying, 359
      preferences, 72
   Filter Selection, Image Gallery dialog box, 356
   filter layers, 114, 124, 125
      isolate layers, 126
filters, 355-392. See also specific types
on adjustment layer masks, 165
Blur Gallery, 376-377
categories of, 356
channel masks controlling effects, 386-387
Fade command with, 384
gradient masks with, 386-387
for layer mask borders, 267
Lens Correction filter, 170-171
Lighting Effects filter, 375
multiple filters, applying, 359
Oil Paint filter, 374
order for applying, 359
Photo Filters, 223, 380
in Quick Mask Mode, 283
selections, controlling filters with, 385
shortcut for reapplying, 357
various filter effects, 390-392
watermarks, embedding, 355, 388-389
Adaptive Wide Angle filter, 372-373
Find and Replace, 327, 343
with Bridge, 552-553
Find Edges filter, 384
FireWire, Scratch Disks with, 57
Fish style of warped text, 336
Fisheye style of warped text, 336
Fit Image command, 462
Fixed Aspect Ratio
with Elliptical Marquee tool, 85
with Rectangular Marquee tool, 84
Flag style of warped text, 336
Flash. See also animated GIFs
flow
for Airbrush tool, 241
for Paintbrush tool, 241
fonts
Character panel selections, 332-333
missing fonts, replacing, 329
neon effects for, 318
of notes, 45
preferences, 58
preview size on menu, changing, 330
types of, 331
Type preferences for, 76
Type tool, working with, 330
foregrounds, 232-233
default and switching of, 233
with Paint Bucket tool, 253
freeform bounding box, 17
Free Transform command, 102
Freeform Pen tool, 290-291
FreeHand, moving shapes to, 251
freezing with Liquify, 361
fresco filter effect, 390
Full Screen Mode, 37
Fuzziness slider, 93
G

gamut. See also out-of-gamut
preferences, 67
Gamut Warning, 197, 416, 482
mask, 67
Gaussian Blur filter, 174
on adjustment masks, 165
with channel masks, 279, 281
with layer masks, 266, 267
Smart Sharpen filter with, 178
General preferences, setting, 58-59
gamey
with Custom Shapes tool, 247
with Line tool, 245
paths, complexity of, 290
with Standard Shape tool, 246
GIF files, 415, 488. See also animated GIFs
creating, 522-523
clipart for Web, preparing, 434-435
compression of, 432
metadata information, adding, 431
opening images, 16
optimizing GIF documents, 492-493
Save For Web command with, 484
saving documents as, 28
for Web images, 483
glass filter effect, 391
Global Light option
for Bevel and Emboss style, 311
with Drop Shadow style, 308
Gloss Contours for Bevel and Emboss
style, 311
glowing edges filter effect, 391
Gradient Map adjustment, 222
Gradient Overlay, 305
Gradient tool, 11
gradients, 231
  creating, 257
  customized gradients, 258-259
  with filters, 386-387
  for Inner Glow style, 321
  for Outer Glow style, 319
  pre-defined gradients, adding, 257
  with Stroke layer style, 315
Graphics Processing Unit (GPU)
  GPU Sniffer, 75
  preferences, 74-75, 530-531
  supporting, 75
grain filter effect, 392
graphic pen filter effect, 392
gray. See also Grayscale color mode
  with layer masks, 262, 264
Grayscale color mode, 13, 195
  Channel Mixer adjustment with, 221
  Color Slider, 206
  converting images to, 198
  Duotone color mode and, 203
  patterns, generation of, 383
  Spectrums or Ramps, 207
  working with, 198
grid size, 70-71
  transparency grid size, 67
groups
  adjustment layers, grouping, 160
  nested layer group, creating, 119
Guides, Grids & Slices options, 70-71
  ruler guides, 48-49
  custom, 45 degree angles, 86

H
H.276, 560-561
halftone screens for press images, 439
Hand tool
  with Lens Correction filter, 170
  with Liquify, 361
  monitor, fitting image to, 40
  moving images, document window, 41
  with Save For Web command, 486
  with Vanishing Point tool, 169
Hard Mix Blending Mode, 162
hard proofs, printing, 420-421, 470-471
hardware color calibration, 465
HDV Anamorphic Pixel Aspect Ratio, 15
Healing Brush tool, 184
  with Reduce Noise filter, 167, 184
height values
  Fit Image command, 462
  with Pattern Maker filter, 383
  print size option, 417
Help menu
  updates, checking for, 25
  using, 26-27
hiding. See showing/hiding
HiDPI, 2, 38-39, 335
High Dynamic Range (HDR) images, 192-193, 226-227
  Exposure adjustment with, 215
  Merge images to, 458-459
  Merge image to, in Bridge, 455
highlights
  for Bevel and Emboss style, 311
  with Dodge and Burn tools, 183
  Shadow/Highlight adjustment, 228
  tonal range, controlling, 188-189
Histogram panel, 190
  for levels, 189
History brush, 141
  combining with History states, 150
  correcting mistakes with, 150
  Eraser tool to, 153
  layers with, 153
  snapshots, working with, 151
History panel, 141-153. See also snapshots
  linear history, 141, 144
  resetting to, 154
  multiple undo commands, 142
  non-linear state of, 141, 144-145
  purging RAM, 154
  saving RAM, 147
  setting options in, 142-143
History states, 56, 74
  controlling, 154
  duplicating, 142, 147
  History brush combined with, 150
  number, setting, 142
  purging, 145, 154
  reviewing text file, 149
  saving, 148
Horizontal Type Mask tool, 347
Hot keys. See shortcut keys
HSB (hue, saturation, brightness)
  Brightness/Contrast adjustment, 191, 216
  Color Slider, 206
  Hue/Saturation adjustment, 218
  opacity of, 162
  Replace Color command and, 205
HTML (Hypertext Markup Language) files
  copying CSS from layers, 139
  generating, 489
  importing color swatch from, 208-209
hue. See HSB (hue, saturation, brightness)
Hue/Saturation adjustment, 218
  for out-of-gamut colors, 478-479
hyphenation
  Character panel selections, 333
  Paragraph panel selections, 334
 ICC Profile
  embedding ICC color profiles, 474
  information, embedding, 29
  for JPEG images, 491
  for PNG images, 494-496
  Windows, 429
Illustrator, 234
  inserting images in, 17
  paths, exporting, 285, 303-304
  Pen tools in, 289
  scripts, using, 411
  shapes to Illustrator, moving, 251
image cache, 55
  preferences, 57
image compression, 415
Image Gallery dialog box, 356
Image menu, Adjustments option, 155
Image Preview, Image Gallery dialog box, 356
Image Processor, 460-461
image pyramid, saving, 441
images, with bit depth (8, 30, and 32), 192-193
importing and exporting. See also paths; SWF files
  digital camera, raw data from, 18-19
  layers to files, exporting, 138
  shapes to vector, exporting, 251
  video, 526-527
  Zoomify, 510
inches as measurement system, 33
Include All Subfolders command, 412
indents
  Paragraph panel selections, 334
  with Standard Shape tool, 246
InDesign, 76
  adjustment layers, opening, 156
  clipping paths in, 285
  EPS documents, type information in, 337
indexed color mode, 195
  converting image to, 200-201
Inflate style of warped text, 336
Info panel, 46
  changing measurement of colors in, 47
  color markers, creating, 46
  displaying information in, 47
  specific size object, creating, 46
ink density. See density
inkjet printers
  getting the best results for, 440-441
  resolution, understanding, 433
Inner Glow style, 320-321
Inner Shadow style, 318-319
Insert Menu command with actions, 407
inserting images in documents, 17
installing Photoshop, 2-3
intellectual property, protecting, 355, 388-389
interface
  preferences, 62-63
interlacing
  for GIF images, 493
  for PNG-8 documents, 495
  for PNG-24 documents, 496
Internet. See also Web design; Web images; Web sites
  help on, 26-27
  saving files for, 28
  updates, checking for, 24
interpolation, 22-23, 58, 286
  press, images for, 439
inverting
  command, 224
  Lens Blur filter option, 379
  textures, 313
IPTC Contract, 430
Iris blur filter, 376-377
isolate layers, 126
  filter layers, 114, 124, 125

J
JavaScript, 411
jitter
  for Inner Glow style, 321
  Liquify tool option, 362
  for Outer Glow style, 319
JPEG files, 415, 427, 488
  compression of, 432
  JPEG 2100 format, 427, 437
  JPEG Stereo, 427
layers exported as, 138
metadata information, adding, 431
opening images, 16
optimizing JPEG documents, 490-491
photographs for Web, preparing, 436-437
printers, preparing images for, 441
raw images saved as, 18
Save For Web command with, 484, 488
saving documents as, 28
transparency, support for, 67
for Web images, 483
justification
  Paragraph panel selections, 334
  of text, 329, 331

K
kerning, 332
keyboard. See also shortcut keys
  paths, moving, 294
Kuler panel, 207

L
Lab color mode, 13, 195
  Color Slider, 206
  converting image to, 202
  patterns, generation of, 383
landscape orientation, 416-417
language options, 329
large files, saving, 22, 61
laser printers, preparing images for, 440-441
Lasso tools. See also specific tools
  Lasso Marquee tool, 87
  for layer mask borders, 267
  Magnetic Lasso tool, 88-89
  Polygonal Lasso tool, 87-90
launching Photoshop, 4-5
Layer Comps panel, 137
layer filters, 114, 124, 125
layer masks, 114, 261
  borders, creating, 267
  creating, 263
  modify, 269
Paint tools with, 264
role of, 262
selections generating, 265
soft transparency, generating, 266
type masks, combining with, 352-353
as white, 264
layer shapes, 246, 248-250
Layer Style dialog box, 307
  customized styles with, 322-323
layer styles, 305-326. See also specific styles
  adding, 307
  combining layer style elements, 322
  customized styles
    with Layer Style dialog box, 322-323
    with Styles panel, 324-325
  to masked images, 265
  modifying existing layer style, 307
  moving existing layer styles, 326
  names for, 323, 325
  saving customized styles, 324
  sharing, 325
  showing/hiding, 307
  single layer styles, moving, 326
  understanding, 306
layers, 113-140. See also adjustment layers; backgrounds; layer masks; layer styles; linked layers; opacity; Type tool
  active document, adding layers to, 116
  blending modes, 135
  comps, creating, 137
  copying, 99, 128
    elements in layers, 121
  deleting, 114, 129
    linked layers, 129
designation of, 115
different file formats, saving documents as, 429
dragging layer thumbnails into documents, 44
Eraser tools with layered documents, 254
exporting as files, 138
filtering, 114, 124, 125, 126
History brush, multiple layers with, 153
isolating, 126
locking, 124
Magic Eraser tool with, 256
Merge options with, 130
moving, 116
documents, layers between, 44, 127
names for, 124
nested layer group, creating, 119
new layers, creating, 116-117
opacity, 136
pasting, 99
properties, changing, 124
saving, 28
selecting layer options, 117
selecting methods, 118
selections from layers, creating, 120-121
showing/hiding, 124
Smart Objects, converting, 21
stacking order, changing, 124
two open documents, moving layers between, 44
updating layer comps, 137
Layers panel, 114. See also layers
controlling image information with, 124
setting options, 140
thumbnail size, changing, 140
tonal range, controlling, 188-189
leading Character panel selection, 333
left justification, 331
length with Line tool, 245
Lens Blur filter
brightness with, 169, 379
Smart Sharpen filter with, 178
working with, 378-379
Lens Correction
automation, 456-457
Camera Raw, Upright filter, 369
filter, 170-171
Levels adjustment, 188-189
for actions, 398
with channel masks, 277
with type masks, 349
working with, 214
libraries, Preset Manager for, 77
Lighting Effects filter, 375
lighting, adjusting, 3D, 541
Line tool, 245
45 and 90 degree angles, 245
linear history. See History panel lines. See straight lines
Link Layers option, Layers panel option, 114
linked layers, 124
with composite adjustment layers, 159
creating, 124, 131
deleting, 129
with Pattern Overlays, 317
textures, linking, 313
unlinking, 131
Liquify, 355
mask options, 364
meshes
applying, 367
creating, 366
modifying loaded meshes, 367
Show Mesh option, 365, 366
modifying images with, 360
options, working with, 362-363
saving meshes, 367
Show Mesh option, 365, 366
Smart Object, 362
view options, 365
Load Mesh button, 366
loading
channel masks, 278-279
meshes, 366
localized color cluster, 93, 205
locking layers, 124
Layers panel option, 114
locking ruler guides, 49
lossless compression, 432
printers, preparing images for, 440-441
lossy compression, 432
for GIF images, 493
luminosity  
with Match Color adjustment, 230  
Photo Filter option, 380  
LZW files  
compression of, 432  
printers, preparing images for, 441  

M  
Macintosh  
color calibrator in, 464  
Embed Color Profile option, 429  
Print Settings in, 422-423, 425  
printers, preparing images for, 441  
printing documents in, 422-423  
Magic Eraser tool, 256  
Magic Wand tool, 92  
channel masks, creating, 275  
Magnetic Lasso tool, 88-89  
with paths, 291  
Make Work Path button, 287  
marching ant marquee, 284  
margins  
in Macintosh Page Print Settings, 425  
Paragraph panel selections, 334  
in Windows, 425  
Marquee tools, 83. See also Elliptical Marquee tool; Rectangular Marquee tool  
Lasso Marquee tool, 87  
Single Row/Column Marquee tools, 86  
type masks, creating, 347  
with Vanishing Point tool, 168  
masks, 114. See also channel masks; layer masks; Quick Mask Mode; selections; Type tool  
with adjustment layers, 164-165  
clipping masks, creating, 117  
Liquify mask options, 364  
Minimum and Maximum filters, 270-271  
Standard Mask Mode, 282  
Match color adjustments, 191, 230  
modify, 269  
vector masks, 262, 268, 269  
Mask Edge button, 266  
match prints, printing, 470-471  
matte option  
clipart for Web, preparing, 434  
for GIF documents, 493  
for indexed color mode, 200  
for JPEG images, 491  
photographs for Web, preparing, 436  
for PNG-8 documents, 495  
for PNG-24 documents, 496  
for Web design, 485  
maximize compatibility, saving, 28-29, 61  
Maximum filter, 270-271  
measurements  
Rulers, 48-49  
system for, 33  
Measurement scale, 50-51, 168  
Measurement Log panel  
counting, 52-53  
taking measurements, 50-51  
memory. See also RAM (random access memory)  
100% Memory Usage option, 75  
preferences, setting, 74-75  
Memory & Image Cache preferences, 74-75  
menus  
color preferences for, 59  
customizing, 80-81  
original settings, restoring, 80  
Mercury Graphics engine (MGE), 75  
Merge Down option, 130  
Merge Image to HDR Pro, 226-227, 455, 458-459  
Merge Visible option, 123, 130  
merging. See also adjustment layers  
Merge Down option, 130  
Merge Visible option, 123, 130  
Photomerge, 454-455  
meshes. See Liquify  
metadata, 13, 552  
adding to files, 430-431  
with Bridge, 552-553  
midtones  
with Dodge and Burn tools, 183  
Shadow/Highlight adjustment for, 228  
tonal range, controlling, 188-189  
Mini Bridge, 558  
Minimum filter, 270-271  
mirroring with Liquify, 361  
missing fonts, replacing, 329  
Mixer Brush tool, 242
mode
  for Airbrush tool, 241
  color, 13, 195
Conditional Mode Change command, 446
  with Custom Shapes tool, 247
  for gradients, 257
  with Line tool, 245
  for Paint Bucket tool, 253
  for Paintbrush tool, 241
  for Pencil tool, 243
monitors. See also color management
  automatically fitting image to, 40
  calibrating, 465
  resolution, understanding, 433
  selecting areas for, 84
  soft-proof colors, setting up, 466-467
monochromatic option
  with Add Noise filter, 166
  with Lens Blur filter, 379
mosaic tiles filter effect, 392
Motion Blur filter
  Add Noise filter with, 166
  Smart Sharpen filter with, 178
  mouse movements in actions, 407
Move Grid tool, 170
Move tool, 11
  with Vanishing Point tool, 168
moving. See also layers; paths
  adjustment layers, 157
  anchor points in paths, 292
  with Bridge, 552-553
  channel masks between documents, 280
  Document window, images in, 41
  layer styles, 326
  with Vanishing Point tool, 168-169
Multi-Channel color mode, 195, 204
multi-layered documents into backgrounds, converting, 123
Multi-Picture Format files, 427
Multiply blending mode
  with layers, 135, 162
  with Pattern Overlays, 316

N
names. See also renaming
  for action sets, 408
  for custom preset document, 12
  of data driven graphics, 526
  droplets, naming options for, 413
  for gradients, 258
  for layer styles, 323, 325
  for layers, 124
native color channels, channel masks from, 276-277
native formats, 492
Navigator panel. See also zooming
  area of view, changing, 35
  color of view box, changing, 36
  shortcuts, 34
  size of view, changing, 34
  thumbnails, sizing and zooming, 35-36
Nearest Neighbor method, 22, 58
neon effects, 318
nested layer group, creating, 119
New Document Preset Resolutions, 68-69
new documents
  creating, 12
  preset resolutions, 68-69
  with presets, 14
New Layer dialog box, 117
New Layer dialog box, 117
New Layer Effect button, 359
noise
  Add Noise filter, 166
  with brush tips, 237
  for Drop Shadow style, 309
  for Inner Glow style, 320
  for Outer Glow style, 318
  Reduce Noise filter, 167
nondestructive editing, 21
non-linear state of History panel, 141, 144-145
non-squared pixels, 15
Notepad (Win), 411
note paper filter effect, 391
notes, 45
different file formats, save as, 429
saving, 28, 45

O
offset with Pattern Maker filter, 383
Oil Paint filter, 374
on-image controls, 229
onion skinning, 524-525
opacity, 67
with adjustment layers, 162-163
for Airbrush tool, 241
with Art History brush, 152
for Bevel and Emboss style, 311
for Color Overlay style, 314
with Custom Shapes tool, 247
for Drop Shadow style, 308
of gradients, 259
for Inner Glow style, 320
Layers panel option, 114
Liquify view option, 365
for Outer Glow style, 318
for Paintbrush tool, 241
with Pattern Overlays, 316
for Pencil tool, 243
setting, 117, 136
for Stroke layer style, 315
OpenCL, 74-75, 530-531
OpenEXR files, 427
OpenGL, 3, 38, 40, 74-75, 530
OpenType font
changing font attributes, 333
defining, 330-331
opening images, 16
Optimize To File Size option, 487
optimizing
image to file size, 487
Photoshop, 56-57
Options bar, 6, 11
organizing documents, 429
outline font, 331
output options, printing, 416-419
out-of-gamut, 67, 197
command, test, 482
Hue/Saturation Adjustment for, 478-479
Sponge tool, working with, 480-481
Out of Scratch Disk Space error, 57
Outer Glow style, 306
working with, 318-319
output options, setting
setting, 504-505
saving, 504-505
Overlay blending mode with Pattern Overlays, 316
Override Action "Open" commands, 412

P
Page Setup, in Print Settings, 425
Paint Brush tool, 83
Paint Bucket tool, 11, 253
Paint tools, 10, 231
with layer masks, 264
Paintbrush, 241
with layer masks, 264
as Stroke tool, 301
painting. See also gradients
adjustment layers, opening, 156
on adjustment masks, 164
cursor options, 66
3D models, 539
painting engine. See Brush panel
panel knife filter effect, 390
panels, 6. See also specific types
adding panels, 7-9
customizing, 78-79
preferences for, 59
showing/hiding, 7-9, 37
subtracting panels, 7-9
working with, 7-9
workspaces, 78-79
panoramic photographs
correcting with Adaptive Wide Angle Filter, 472-473
creating, in Photoshop, 454-455
creating, in Bridge, 455
Pantone Color Matching System, 463
paper options, 425, 423
Paragraph panel, 78-79
showing/hiding, 331
working with, 333, 334
Paragraph Styles panel
creating styles, 338-339
Paste, preferences for resizing, 59
pasting, selection, 99, 127
Paste in Place, Paste Into, 99, 127
Patch tool, 184-185
with Content-Aware Fill, 110
with Reduce Noise filter, 167
patches, checking for, 24-25
Path Selection tool, 294
type path, reshaping, 354
paths, 304. See also Type tool
anchor points
adding, 292
converting, curved to straight points, straight to curved points, 297
deleting, 292-293
direction lines, modifying, 296
with Magnetic option of Freeform Pen tool, 291
modifying, 294-295
moving, 292
clipping paths, 285
working with, 298-299
complexity of path, controlling, 290
curved to straight points, converting, 297
deleting anchor points, 292-293
direction lines, modifying, 296
Fill command with, 285, 300
Freeform Pen tool, 290-291
Magnetic option, using, 291
Illustrator, exporting paths to, 303-304
keyboard, moving path with, 294
Magnetic option of Freeform Pen tool, using, 291
 moving anchor points, 292
keyboard, moving path with, 294
Paths To Illustrator command, exporting paths with, 304
Pen tools with, 285, 288-289
Save As, exporting paths with, 303
selections into paths, converting, 287
shapes as paths, creating, 302
straight to curved points, converting, 297
Stroke command with, 285, 301
Paths panel, 285
Paths To Illustrator command, 304
Pattern Maker, 355, 382-383
Pattern Overlays, 305
repositioning, 317
working with, 316-317
patterns
with Paint Bucket tool, 253
for Stroke layer style, 315
for texture, 313
pauses in actions, 402
PBM files, 427
PCX files, 427
PDAs (personal digital assistants), 196
 RGB (red, green, blue) color with, 468
PDF files, 427, 443
 creating, saving, 450-451
format, 451
inserting images in, 17
layers exported as, 138
metadata information, adding, 431
multi-page PDFs to PSDs, converting, 448-449
PSD file, converting to, 448-449
types of, 450
PDF presentations, 427, 443
 creating, 450-451
PDF presets
 creating, working, 451
Pen tools
in Illustrator, 289
with paths, 285, 288-289
Pencil tool, 243
 Auto Erase and, 244
for calligraphy lettering, 243
perceptual rendering intent, 469
Performance, 56-57, 74-75, 530-531
Perspection web site, 11
Perspective Crop Tool, 106
perspective of Transform command selection, 103
Photo Filters, 223, 380
photographic manipulation, 181
photographic restoration, 166
photographs for Web, preparing, 436-437
Photomerge, 454-455
Photoshop, 32-bit or 64-bit, 3, 5
Photoshop Extended, 529
picas as measurement system, 33
PICT files, 427
Pincushion distortion, 170-171
Pixar files, 427
Pixel Aspect Ratio Correction, 15
 pixelization, 13
 pixels, 13. See also adjustment layers; raster data
 Add Noise filter, working with, 166
of data driven graphics, 526
of data sets, 509
Equalize command, 224
with Eraser tool, 232
excess pixels, deleting, 44
Histogram panel, information in, 190
pixels (continued)
image interpolation, 58
large files, saving, 22
Magic Eraser tool with, 256
as measurement system, 33
non-squared pixels, 15
resolution, understanding, 433
with RGB (red, green, blue) color, 468
Smart Sharpen filter, 178-179
Unsharp Mask filter, 175
Place command
inserting images in documents with, 17
preferences for resizing, 59
placeholder text, inserting, 329
plastic wrap filter effect, 392
Play button, Actions panel, 395
play options, 412
playback of command, controlling, 399
Plug-ins, 72
preferences, 72
PNG-8 files
information on, 432
optimizing PNG-8 documents, 494-495
saving for the Web, 484-485
PNG-24 files
information on, 432
optimizing PNG-24 documents, 496
saving for the Web, 484-485
PNG files, 427
clipart for Web, preparing, 434-435
comression of, 432
layers exported as, 138
metadata information, adding, 431
opening images, 16
photographs for Web, preparing, 436-437
Save For Web command with, 484-485, 488
saving documents as, 28
for Web images, 483
Polygonal Lasso tool, 87-90
polygons
Polygonal Lasso tool, 87-90
with Standard Shape tool, 246, 248-249
portrait orientation, 416-417
position for Stroke layer style, 315
Posterize adjustment, 225
PostScript type size, 48, 76
precise cursor options, 66
preferences, 55
cursors preferences, 66
File Compatibility preferences options, 28-29, 61
File Handling preferences, 60-61
gamut preferences, 67
General preferences, 58-59
Guides, Grid & Slices preferences, 70-71
interface preferences, 62-63
Memory & Image Cache preferences, 74-75
Performance, 56-57, 74-75, 530-531
Plug-ins preferences, 72
resetting preferences, 59
scratch disks preferences, 73
Sync Settings preferences, 64-65
3D preferences, 530-531
transparency preferences, 67
Type preferences, 76
Units & Rulers preferences, 68-69
Preset Manager for libraries, 77
presets
new documents with, 14
Preset Manager, 77
saving items and, 77
tools, 54
press, preparing images for, 438-439
previewing
toclars, 76, 330-331
Lens Blur filter option, 379
non-squared pixels, 15
press, images for, 439
with Save For Web command, 486
transparency settings, 67
with Unsharp Mask filter, 175
Print One Copy command, 426
Print dialog box with preview, 416-419
printers. See also Windows
calibrating, 465
converting color space to another
profile, 476
preparing images for, 440-441
printing
Gamut Warning, 416
hard proofs, 470-471
larger images, 426
Macintosh, documents in, 422-423
one copy of document, 422
output options, 416-419
Print dialog box with preview, 416-419
Show Paper White, 416
Windows, documents in, 422
problems, reporting, 25
progressive option
for JPEG images, 491
photographs for Web, preparing, 437
proof profile information, embedding, 29
Proof Setup, Windows, 429
Protect Texture option, 237
Protect Tones, 183, 480
PSB files, 427
opening images, 16
PSD files, 427
adjustment layers as, 156
creating, 450-451
as a presentation, 451
large files, saving, 22
layers exported as, 138
metadata information, adding, 431
multi-page PDFs to PSDs, converting, 448-449
opening images, 16
PDF files, converting, 448-449
preferences for saving, 61
raw images saved as, 18
puckering with Liquify, 360
Puppet Warp tool, 112
purging RAM, 145, 154
pushing left with Liquify, 360
Q
QuarkXpress, 298
EPS documents, type information in, 337
Quick Mask Mode, 284, 282
filters in, 283
options, working with, 283
saving selections, 283
Quick Selection tool, 91
R
Radial filter, Camera Raw, 370, 550-551
Radiance files, 427
radius option, 172-173, 175, 178-179, 246, 379
RAM (random access memory), 55. See also History panel; History states
adjusting options, 74-75
optimizing, 57
purging RAM, 145, 154
ramps, 207
range values
for Bevel and Emboss style, 312
for Inner Glow style, 321
for Outer Glow style, 319
raster data, 433. See also Layers panel
change and, 415
documents, 13
interpolation and, 286
saving, 428-429
Smart Objects with, 21
understanding raster images, 286
Rasterize Type command, 344
raw digital camera data, importing, 18-19
RAW files, 18-19, 427
large files, saving, 22
reconstructing with Liquify, 360, 363
Record button, Actions panel, 395
recording actions, 397
Rectangle tool for layer mask borders, 267
rectangles
with Rectangle tool, 246, 248-249, 267
with Rounded Rectangle tool, 246, 248-249, 267
Rectangular Marquee tool, 84
with Pattern Maker filter, 382
RedEye tool, 187
Reduce Noise filter, 167
with Healing Brush tool, 167, 184
reduction
for GIF documents, 492
for PNG-8 documents, 494
Refine Edge
selection, 94-95
with Layer Masks, 266
registration marks, printing, 418
relative colorimetric rendering intent, 469
remove option, Smart Sharpen filter, 178
renaming
with Bridge, 557
presets, 77
rendering intent
for hard proofs, 471
for soft-proof colors, 466
working with, 469
repeating Transform command selection, 103
Replace Color command, 205
Resample Image option, 22
resizing. See size
resolution
  changing, 22-23
  selecting, 13
  understanding, 433
retouching images, 181
RGB (red, green, blue) color, 13, 47, 195.
  See also color management; out-of-gamut
CMYK (cyan, magenta, yellow, black)
  color and, 195, 468
Color Slider, 206
  converting image to, 196
  with 8-bit channels, 192-193
Gamut Warning mask, 67
Lab color mode for images, 202
Multi-Channel color mode, converting images to, 204
patterns, generation of, 383
press, preparing images for, 438-439
Spectrums or Ramps, 207
right justification, 331
Rise style of warped text, 336
RLE (Run Length Encoding) scheme, 434
Rotate View tool, 41
rotating
  with Bridge, 552-553
  with Lens Blur filter, 379
  Smart Objects, 21
  Transform command selection, 103
roughness of gradients, 259
roundness, 270-271
rows. See columns and rows
rulers, 48-49
  guides, working with, 48-49
  options for, 68-69
  switching between measurements, 68
S
Saturate and Desaturate command, 191
saturation. See also HSB (hue, saturation, brightness)
  rendering intent, 469
  Saturate and Desaturate command, 191
Save As command, 29
  paths exported with, 303
  with text, 331
Save commands.
  understanding, 29
Save For Web command, 484-485
Save for Web dialog box, 487
Save Mesh button, 366
Save Optimized As command, 489
saving. See also actions; layer styles
  Auto Save, 28-29, 60-61
  alpha channels, 28
  brush tips, 240
  channel masks, 278-279
  custom shape sets, 252
  documents, 28-29
  file formats, files with different, 428-429
  File Saving options, selecting, 60
  gradients, 258-259
  History states, 148
  image pyramid, 441
  inserting file information into documents, 430-431
  large files, 22, 61
  layer styles, 324
  layers, 28
  Liquify meshes, 367
  maximize compatibility, saving, 28-29, 61
  notes, 28, 45
  preferences, 60-61
  presets, items as, 77
  Quick Mask selections, 283
  spot colors, 28
  Swatches panels, 209
  thumbnail data, 29
  understanding Save commands, 29
  for Web, 484-486
scaling
  Content-Aware scaling, 107
  Character panel selections, 333
  with Pattern Overlays, 317
  in Print dialog box with preview, 419
  Smart Objects, 21
  for texture, 313
  Transform command selection, 103
scanners
  calibrating, 465
  noise from, 167
photographs for Web, preparing, 437
Photoshop, scanning images into, 17
Scattering, 234, 237
Scratch Disks, 55, 57
preferences, 73
scratch sizes, 30
Info panel displaying, 47
Screen blending mode, 162
with Pattern Overlays, 316
Screen Mode for display, 37
scripting
Adobe ExtendScript Toolkit, 544, 559
scripts, using, 41
scroll wheel preferences, 59
scrubby sliders, 11
Scrubby Zoom, 40, 59
SCT files, 427
searching. See Find and Replace
Select menu options, 98
selection marquees, hiding, 481
selection masks, 100-101
selections, 10, 83-105. See also specific tools
adding to, 96-97
Brightness/Contrast adjustment with, 217
channel masks from, 275
channels, creating with, 100
by color range, 93
cropping selections, 104-106
filters, controlling, 385
with Free Transform command, 102
layers, 118
layer masks, generation of, 265
layer options, selecting, 117
masks, 100-101, 165
layer masks, generation of, 265
modifying existing selection, 98
paths, converting to, 287
Quick Mask option, 284
Quick Selection tool, 91
Refine Edge, 94-95
subtracting from, 96-97
with Transform command, 102-103
Selective Color adjustments, 191, 220
sepia color, Fill blending with, 211
sets. See actions
Shadow Angles option with Drop Shadow style, 308
Shadow/Highlight adjustment, 228
shadows
for Bevel and Emboss style, 311
with Dodge and Burn tools, 183
Shadow/Highlight adjustment, 228
tonal range, controlling, 188-189
Shake Reduction filter, 176-177
Shape Blur filter, 172-173
Shape Dynamics, 234, 237
shape layers, 115
arranging, 250
creating, 248
drawing option, 302
work with, 248-249
Shape Marquee tools, 11
Shape tool, 231, 246-247
shape layer, 248-249
shapes
creating, 248-249
Custom Shapes tool, 247, 251-252
editing and re-editing, 248-249
Lens Blur filter option, 379
paths, creating shapes as, 302
on a shape layer, 246, 248-249
with Standard Shape tool, 246
Type tool, creating shape layers with, 346
sharing
actions, 410
layer styles, 325
Sharpen tool, 180
Shell Lower/Upper style of warped text, 336
Shift key for tools, 11
shortcut keys, 3, 4
defining new, 82
filters, reapplying, 357
list of, xix
with Navigator panel, 34
for tools, 11
working with, 82
zooming with, 39
Show Paper White, 416
showing/hiding
channel masks, 273
Character panel, 331
layer styles, 307
showing/hiding (continued)
layers, 124
Navigator panel, 35
panels, 7-9, 37
Paragraph panel, 331
selection marquee, 481
toolbox, 37
shutter speed information, 430
sign in and sign out.
Adobe Creative Cloud, 4-5, 25, 564
Single Row/Column Marquee tools, 86
size
adjustment layers and, 155
for Bevel and Emboss style, 310
of CMYK document, 195
of documents, 30
for Drop Shadow style, 309
image size, changing, 22-23
Info panel, information in, 46, 47
for Inner Glow style, 321
for Outer Glow style, 319
photographs for Web, preparing, 437
preferences for resizing, 59
for Stroke layer style, 315
view size, changing, 34
sketch filters, 356
skewing Transform command selection, 103
skin tones, detect faces, 93
Slice Selection tool
with Save For Web command, 486
slicing images, 498-499
arranging, 502-503
distributing, 502-503
HTML text, add, 506-507
saving for the Web, 504-505
setting output options, 504-505
stacking, 502-503
URL, add Web address, 506-507
working with, 70-71, 500-501
slide shows, 450-451
sliders, changing text boxes to, 80
Smart Filters
Camera Raw, 368
Creating, 358
Smart Objects, from, 20-21
Working with, 358
Smart Guides, 134
Smart Objects, 20-21
apply Smart Filter, 358
converting 3D layer to, 21
inserting image as, 17-19
preferences, 59
Smart Sharpen filter, 178-179
smoothness
of gradients, 259
with painting engine, Brush panel, 237
Smudge tool, 180
snapshots, 142
creating, 146
with History brush, 151
softness
for Bevel and Emboss style, 310
channel masks, 279
layer masks, soft transparency, 266
soft-proof colors, setting up, 466-467
software color calibration, 465
sounds, preferences for, 59
source option for Inner Glow style, 321
spacing Paragraph panel selections, 334
Spatter filter, 392
for layer mask borders, 267
specific size object, creating, 43
spectrums, 207
speed of Photoshop, adjusting, 74-75
Spell Check, 327
Character panel selections, 333
checking, 342
working with, 342
Sponge tool, 183
desaturating areas of image with, 218
for out-of-gamut colors, 480-481
spot colors, 212
file formats, saving documents as, 429
saving, 28
Spot Healing Brush tool, 186
Content-Aware fill, 108-109
Spot Removal filter, Camera Raw, 371, 550-551
spread values
for Drop Shadow style, 309
for Outer Glow style, 319
squareness, 270-271
squares with Standard Shape tool, 246, 248-249
Squeeze style of warped text, 336
Index

stacking images, 132
stacking order of layers, 124
stained glass filter effect, 392
stamp filter effect, 391
Stamp tool
  Clone Stamp tool, 181
  with Vanishing Point tool, 168
Standard Mask Mode, 282
Standard Pen tool with paths, 288
Standard Screen Mode, 37
Standard Shape tool, 246, 248-249
  Options bar, 11
stars with Standard Shape tool, 246, 248-249
Status bar, 30
Stop button, Actions panel, 395
straight lines
  drawing, using a brush, 236
  Line tool for, 245
  Pencil tool for, 244
Straighten button, Ruler tool, 48-49
Straighten tool, 170
Stroke command, 210
  for paths, 285
  with paths, 301
Stroke layer style, 315
Stroke Path option, 301
styles. See also layer styles
  for Art History brush, 152
  for Bevel and Emboss style, 310
  for default type, 341
  for type, 338-340
Styles button for warping text, 336
Styles panel, 305
  layer styles, creating, 324-325
stylize filters, 356
subfolders
  in Batch File Processing, 441
  Include All Subfolders command, 412
subtracting from selection, 96-97
Suppress Color Profile Warnings, 412
Suppress File Open Options Dialogs, 412
Surface Blur filter, 172-173
SVG
  importing color swatch from, 208-209
Swatches panel, 208-209
  customizing, 209
  loading or importing, 209
  saving, 209
sync settings
  checking for, 564
  preferences, 64-65
  status bar, 30
system requirements, 3
T
tablecloth, 67
Targa files, 427
  layers exported as, 138
technique
  for Bevel and Emboss style, 310
  for Inner Glow style, 321
  for Outer Glow style, 319
text, 33. See also anti-aliasing; notes; Spell Check; Type tool; warping
  Asian text options, 76
  chiseled text, creating, 320
  of data sets, 509
  History state text files, reviewing, 149
  Rasterize Type command, 344
  workspace for, 78-79
text boxes to sliders, changing, 80
TextEdit (Mac), 411
textures, 234, 237
  with Bevel and Emboss style, 312-313
  filters, 356
  Protect Texture option, 237
thawing with Liquify, 361
32-bit images, See also High Dynamic Range (HDR) images
3D effects, Bevel and Emboss style for, 310
3D model files
  adding to a 2D model, 532-535
  adding 3D objects, 538
  baking 3D objects, 538
  converting 3D layer to Smart Object, 21
  creating
    from a 2D image, 532-533
    from a grayscale image, 532-533
    instance 3D objects, 538
    from a multi-frame file (3D Volume), 532-533
    from a shape preset, 534
    from type, 540
  deleting 3D objects, 538
### 3D model files (continued)
- duplicating 3D objects, 538
- exporting a model, 542
- files, 530-542
- grouping objects, 538
- lighting, 541
- merging 3D layers, 538
- modifying a 3D model, 536-537
- painting, 539
- preferences, 530-531
- render a model, 542
- saving a file with a model, 542
- 3D material eyedropper tool, 539
- 3D material drop tool, 539
- workspace, viewing, 535
- threshold, 225
  - with Lens Blur filter, 379
  - with Surface Blur filter, 172-173
  - with Unsharp Mask filter, 175
- thumbnails. *See also Navigator panel*
  - with Bridge, 13
  - in Brush Presets panel, 235
  - dragging layer thumbnails, 44
  - file saving options, 60
  - Layers panel thumbnail size, changing, 140
  - with Save For Web command, 486
  - saving thumbnail data, 29
- TIFF files, 427
  - adjustment layers as, 156
  - large files, saving, 22
  - layers exported as, 138
  - metadata information, adding, 13, 431
  - opening images, 16
  - photographs for Web, preparing, 436-437
  - preferences for saving, 61
  - printers, preparing images for, 440-441
  - raw images saved as, 18
  - tile boundaries with Pattern Maker filter, 383
- Tilt-Shift blur filter, 376-377
- tolerance
  - for Art History brush, 152
  - with Paint Bucket tool, 253
  - for paths, 287
- tonal values
  - controlling, 188-189
  - Histogram panel and, 190
- Invert command for, 224
  - with Smart Sharpen filter, 179
  - with Surface Blur filter, 172-173
- tool tip preferences, 59
- toolbox, 6
  - showing/hiding, 37
- tools. *See also specific tools*
  - multiple tools, accessing, 10
  - working with, 10-11
- tracking Character panel selections, 333
- Traditional type size, 48
- transfer functions for press images, 439
- Transform command, 102-103
  - with Vanishing Point tool, 168
- transparency. *See also layer masks*
  - clipart for Web, preparing, 434
  - clipping paths and, 298-299
  - for GIF documents, 493
  - for gradients, 257
  - gray creating, 262, 264
  - with History brush, 153
  - for JPEG images, 491
  - layer styles requiring, 306
  - for PNG-8 documents, 495
  - for PNG-24 documents, 496
  - preferences, 67
  - printer, preparing images for, 441
  - soft transparency, generating, 266
  - for Web design, 485
- TrueType font
  - defining, 330-331
- turbulence with Liquify, 361
- turning on/off Smart Guides, 134
- tweening, 524-525
- twirling with Liquify, 360
- Twist style of warped text, 336
- Type 1 PostScript font
  - defining, 330-331
- Type preferences, 76
- type styles
  - for default type, 341
  - for type, 338-340
- Type tool, 10, 327-354
  - anti-aliasing, 335
  - chiseled type, creating, 350-351
  - editing type on path, 329
  - extrude to 3D, 351, 540
fonts, working with, 330-331
horizontal and vertical type, toggling between, 330
layers, creating, 115, 346
masks
chiseled type, creating, 350-351
creating type masks, 347
layer masks, combining with, 352-353
pixels, isolating, 348-349
special effects, generating, 352-353
moving type mask, 348
options, working with, 330
orientation, changing, 330
paths, 328-329, 345
text on path, creating, 354
work paths, creating, 345
placeholder text, inserting, 329
preferences for, 76
Rasterize Type command, 344
resize type box, 331
rotate type box, 331
shape layers, creating, 346
skew type box, 331
special effects, generating, 352-353
standard typing tools, 328-329
Type menu, using, 328-331

V
Vanishing Point tool, 168-169
variables, data, 508-509
vector data
interpolation and, 286
Paths panel and, 285
press, images for, 439
saving, 428-429
Smart Objects with, 20-21
understanding vector images, 286
vector masks, 262, 268, 269
Vertical Type Mask tool, 347
vibrance, 193, 219
video, layers, 511
adjustment layers, adding, 517
audio, adding, 521
cache, clearing, 154
cloning, 519
creating and modifying, 513-515
exporting, 526-527
Frames view, 522-525
grouping, 516
new documents with video presets, 14
opening, formats, 512
preview option, 14
rasterize, creating still image, 528
splitting, 518
stacking order, 517
text, adding, 517
transitions, adding, 520
Video Timeline view, 513-525
views and viewing. See also Navigator panel
Bird’s Eye view, 38-39
with Bridge, 546, 552-553
for Brush Presets panel, 235
Liquify view options, 365
Photoshop window, 6
RGB color mode, 13, 195
size of view, changing, 34
two views, working on one image in, 43
Zoom tool, changing view with, 38-39
vignettes
Lens Correction filter, vignetting and, 170
Radial filter, 370
Vimeo, 560-561
Visual Basic, 411

U
undos, 56. See also History panel
multiple undo commands, performing, 142
unified color table
for GIF images, 493
for PNG-8 documents, 495
units, 55. See also rulers
options for, 68-69
Unsharp Mask filter, 175
Updater, 24-25
updates
checking for, 24-25
from Internet, 24
layer comps, updating, 137
options, setting, 4
for versions of Photoshop, 2
Upright filter, Camera Raw, 369, 550-551
user interface, customized, 62-63, 80-81
visibility
  of data driven graphics, 509
  of data sets, 509

W
Warped Text button, 331
warping
  with Liquify, 360
  Smart Objects, 20-21
text, 331, 336-337
  Transform command selection, 103
watermarks
  embedding, 355, 388-389
  restricted, 389
Wave style of warped text, 336
WBMP files
  optimizing WBMP documents, 497
  Save For Web command with, 484-485, 488
  for Web images, 483
Web Content panel, 505
Web data variables, 508-509
Web design, 483-510
  file formats, working with, 488-489
  optimizing image to file size, 487
  saving documents for, 484-486
Web images
  clipart, preparing, 434-435
  Color Slider, 206
  lossy/lossless compression, 432
  photographs for Web, preparing, 436-437
  preparing, 415
Web Photo Gallery, Bridge, 553
Web snap
  for GIF documents, 492
  for PNG-8 documents, 494
Wet Edges, 237
width values
  Fit Image command, 462
  with Line tool, 245
  with Pattern Maker filter, 383
  print size option, 416
Windows
  color calibrator in, 464
  ICC Profile, 429
  Microsoft ICM color management, 476
  Printer Settings in, 425
printers
  preparing images for, 440-441
  setting up, 425
  printing documents in, 424
  Proof Setup, 429
workspace, using and customizing, 78-79
WYSIWYG type, 76
X
XMP files, 13
  inserting file information into documents, 430-431
  XMP Software Development Kit, 431
Y
YouTube, 560-561
Z
ZIP files
  compression of, 432
  printers, preparing images for, 441
Zoom tool, 33
  with Lens Correction filter, 170
  with Save For Web command, 486
  two views, working on one image in, 43
  with Vanishing Point tool, 169
  view of image, changing, 38-39
  Scrubby Zoom, 40, 59
Zoomify, export, 510
zooming, 6. See also Zoom tool
  area of view, changing, 35
  with Liquify, 361
  monitor, automatically fitting image to, 40
  on multiple documents, 40
  with Navigator panel, 34-35
  106%, automatically zooming to, 40
  preferences for, 59
  Scrubby Zoom, 40, 59
  with shortcut keys, 39